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Installing WireCAD Version 3 
Insert the CDROM. The WireCAD installer should start automatically. If not, open the CDROM drive in explorer, or run the set-up utility 
setup.exe from the command line. 

If you are installing WireCAD for the first time, WireCAD will install to the location of your choosing. 

The WireCAD installer will also repair damaged installations. Simply re-launch the setup program. Note that this can have undesirable 
results, as it will replace the databases that you may have modified with clean versions. 

Operating System Specific Issues  
Operating System  

Windows 95 Unsupported  

Windows 98  Unsupported 

Windows 98SE Unsupported 

Windows NT 4 Unsupported 

Windows ME Unsupported 

Windows 2000 Supported. 

Windows XP All 
Flavors 

Supported. 
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WireCAD Program Levels Authorization 
WireCAD Personal Authorization Code Required. Available from http://www.WireCAD.com. 

WireCAD 
Professional 

Authorization Code Required. Available from http://www.WireCAD.com. 

WireCAD 
Professional Trial 

Enter 0656-0464-3889-2491-3627-4434-1030 in the authorization code field 
and click Authorize to activate the professional mode for 15 days. 

WireCAD Enterprise Authorization Code Required. Available from http://www.WireCAD.com. 



 

 9

How to Obtain Technical Support 
Please visit the WireCAD Support Forum at www.wirecad.com 

Support contacts: support@wirecad.com or phone at: (661) 253-4370.  

When you first purchase WireCAD you will receive free support for 30 days from the time of your purchase. The User Support forum 
on the WireCAD website is available to all users, and provides a peer-to-peer moderated support forum.  

WireCAD Assurance Programs  

Level Description  Monthly Cost 

Silver Receive all minor updates for free, 2 phone support occurrences* per anum, unlimited 
email support. 

$9.99/seat 

Gold Receive all minor updates for free, unlimited phone support occurrences, unlimited 
email support, access to all advanced tutorials. 

$24.99/seat 

Platinum Receive all minor updates for free, unlimited phone support occurrences, unlimited 
email support, access to all advanced tutorials, free webex support. All Major updates 
for free!  

$49.99/seat 

 

When calling for technical support, please have your Customer Assurance Identification Number. Call us at the number listed above. 

* Support Occurrence is defined as any number of phone or email contacts required to reach a resolution for the user’s question or 
concern. A Support Occurrences will further be defined as any question or concern that does not result in the discovery of a deficiency 
in the software. You will not be penalized for software bugs. 

Please note that we will not be able to respond to your support requests unless your assurance account is current and in good 
standing. 

 

 

mailto:support@wirecad.com
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WireCAD Concept 

 

WireCAD 3 integrates drawing, reporting, and data environments. 
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What is WireCAD? 
WireCAD is a cable management and facility design tool that allows you to easily create AutoCAD™ 
drawings. WireCAD maintains a database of equipment, from which you can create equipment blocks for 
your drawings. Equipment blocks are created dynamically from information stored in the equipment 
database. Rather than maintaining a large library of equipment blocks or symbols, WireCAD stores this 
information in a database and then creates blocks from the equipment definitions contained therein.  
Equipment definitions are easily added to the database. In addition to equipment databases, WireCAD also 
provides drawing tools to rapidly create documentation, and database management tools to track: 

• Projects. 
• Drawings. 
• Revisions. 
• Cable Types. 
• Signal Types. 
• Connectors. 
• Jack Fields. 
• Jacks. 

The biggest time saver comes when it is time to assign System Names and Cable Numbers to the 
equipment in your drawing. No longer do you have to extract all of the attributes of your drawing to a file, 
and then import that file into a spreadsheet for ID assignment, and then get out your highlighter pen and 
your drawing as you manually modify your drawing using the information from your spreadsheet. Now, all 
you do is double-click on the equipment pieces in the drawing to assign them a system name. Then 
double-click on the cable and assign it a cable number. All of the information regarding the selected cable 
is extracted from the drawing and placed in the project cables database and the drawing is updated with a 
new cable number.  
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Extensive reporting is available for the project databases including: 
• Project drawings. 
• Project revisions. 
• Cable run sheets. 
• Cable kill sheets. 
• Cable labels. 
• Equipment lists. 
• Bill of Materials. 

In addition, a powerful report designer is included with WireCAD for creating your own reports and labels, or modifying existing report 
definition files. 
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Terminology 
 
WireCAD: A fully integrated drawing, reporting, and cable management tool that aids in the production of 
single line drawings and database management.  

   
Equipment Block: A representation of a piece of technical equipment to be connected to another piece of 
equipment. These are created dynamically from the Equipment Library in WireCAD. The basic 
characteristics of the block such as width and pin spacing can be edited in the Preferences dialog.  

 

AutoCAD Block: A named group of drawing entities that can be inserted into the drawings any number of 
times. As an example, group of entities that represents a door could be inserted into the drawing multiple 
times.  
   

Insert: An instance of a Block.  

 
Assignment or Cable Assignment or System Assignment: The process of retrieving information from 
the drawing, checking it against existing database entries, and finally appending the database with the data 
from the drawing. This data is then available for reporting. 

 

Current Project: This is the currently active project in WireCAD. This directs WireCAD to the location for 
the project drawings and database.  
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Jack Field: An array of Jacks mounted to a single panel. Jack Fields must be assigned to Projects. This is 
different from adding a Jack Field to the library. Not until a Jack Field is assigned to the project are all of 
the Jacks within that field available for assignment.  
   

 
Jack: The electrical representation of a Jack Field point. WireCAD provides three types of jack for you to 
choose from. The above Jack actually represents two Jacks in a full normal configuration. The A and B 
Represent the top and bottom rows, VPB-1 is the system name and 12 represents the 12th column in the 
array.  

 

 

Terminal: Any junction or splice in a cable. This could be a single bulkhead connector on a service panel, 
or a set of points in a high density connector.  
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Unlinked Pointers: A Pointer to another system in the project. Pointers can be Linked across drawings, or 
in the same drawing. A cable cannot be assigned to the database until any Pointers on the cable are 
Linked together.  
 

 

 
Linked Pointers: A Linked Pointer is represented by red text and a number in the JF attribute. The 
Pointers in the top drawing are Linked together. The blue 8 is there for your convenience; the red test 
indicates that the opposite Pointer is contained on the sheet ‘test.’ With the Pointers Linked, WireCAD will 
assign the cable even if the Source and Destination are on separate sheets. You must open the drawings 
where the Source and Destination reside. Once the cable is assigned a Cable Number, WireCAD will 
automatically fill in the rest of data shown in the Pointers.  
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Distribution Amplifier (DA):  
  

Equipment Type: Used in the Add Equipment Dialog. The Equipment Type is used as a prefix to the 
system name. As an example, if you enter a piece of gear with the Equipment Type VTR, then WireCAD 
uses VTR as the prefix for the system name. So the first instance of the piece of gear would be VTR-01. 
Try to use friendly names for the Equipment Types. For example an Avid non linear editor is easily 
identified as an Avid-1. Instead of non-linear editor, or NLE-1.  
  
 

Note:   
WireCAD imposes a string length of 32 characters on the length of System Names or I/O labels. Keep in mind, 

however, that if you are planning to print cable labels, and if your names are too long, the report may truncate 
them, thereby rendering them unreadable or ambiguous. 

 

Application Path: The path where WireCAD is installed (alternately referred to as InstallPath). See the 
section on Support Paths. 
   
Project Path: The path for the Currently active Project. See the section on Support Paths. 
   

Report Definition File: A file that contains the design for a report. This file also contains the initial data 
Source for the report. The format for the Report Definition File is XML. 
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Typical Work Flow 
A typical workflow might include: 

• Concept level drawings with just enough information to complete an approval process. 
• Bid level drawings with all of the necessary information to go to bid. 
• Construction documentation with associated cable and system databases. This is the most tedious process and is made 

easy by WireCAD. 

The Process 
The user starts by creating a project in WireCAD and then adding drawings to the project. Once a drawing is created in WireCAD it 
has all of the necessary layers, block, and text styles to accept input from WireCAD . Next the user opens the “Equipment Library” 
from WireCAD and selects a piece of equipment for placement in the drawing. The user has the ability to dynamically choose the 
configuration in which the piece of equipment is represented. i.e. if you are creating a drawing that only displays the video connections 
of a system, then all of the equipment in the drawing can be represented with only the video connections displayed. Equipment that is 
not currently in the database can be added very quickly using the “Add Equipment” and “Edit I/O” functions. Once the user has placed 
equipment in the drawing, they then connect the equipment through any terminal gear that is needed, such as Jacks, J-Boxes and 
Routers. WireCAD helps to automate this process by providing a set of tools to speed the process. At this point you should have a 
pretty drawing of your system, but WireCAD has only just begun. Next you assign system names or SysNames to all of the equipment 
in the drawing. During this process, you will also be prompted for the location of the piece of equipment. WireCAD also supports 
system aliases or function names. Once you have assigned system names to all of the equipment in the drawing it is time to assign 
cable numbers to the cables. WireCAD automates this process as well. All you have to do is double-click the cables in the drawing. 
WireCAD then gets the information from the drawing and checks it against the information already stored in the database. If no 
duplicates are found then the cable information is sent to the Project database. WireCAD then assigns a cable number and modifies 
the drawing. Now you have a pretty drawing with all of the system info and all of the cable numbers. Now it is time to build the thing. 
WireCAD will produce cable run sheets and cable labels, as well as, and equipment lists.  

Typical Drawings 

The type of and quantity of drawings required for a given project is highly subjective based on the size of the project, the size of the 
printed drawing, and the density of the drawings. Other considerations will be the requirements imposed by the client. That said, most 
integration documentation includes the following:  

• Connector pin-outs.  
• Connector wiring specifications.  
• Floor plans. 
• Cable chase plans and elevations. 
• Single line drawings for all cables.  
• Jack Field layouts and designations.  
• Patch panel and J-Box mechanical specifications.  
• Drawing Conventions.  
• Title page.  
• Drawing table of contents.  
• Cable riser diagrams.  
• Rack and furniture elevations.  

In addition to the above drawings, you will need to provide documentation to the wiring crews regarding 
cable runs, and labels. Power consumption, weight, and heat load data should be compiled for the 
mechanical and electrical engineering staff 

.  
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Databases 
WireCAD uses the Microsoft JET engine 4.0 (Access 2000 databases) to perform all of the data storage. 
There are two databases that reside in the WireCAD folder in the Installation path. The first one is named 
dbWirePM.mdb. This database maintains pointers to, and meta-data on, all of the projects. The second is 
named dbEquip.mdb, and contains all of the equipment libraries. A third database is the project database 
that is contained in every project directory in a sub folder named Project Databases. This database is 
duplicated for all new Projects, and contains all of the project specific System Names, and Cables, Drawing 
pointers, etc. 

 

Enterprise Client Edition Note:  
Depending on your system configuration, the dbPM.mdb and 
dbEquip.mdb must be located on a server or network share. 
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Microsoft Access 2000 
If you own a copy of Microsoft Access 2000 then you will have the ability to add custom reports and labels, 
as well as custom queries.  

Note: if you are using Access 2000 to create a report in a Project Database, the report will be specific to that database unless 
you copy it, and paste it to another Project Database using the clipboard.  

Note: If you use Access 2000 instead of the Report Designer provided in WireCAD, then you will not be able to print these 
reports from within WireCAD.  

 

The Getting Started Dialog 
When you first start WireCAD you will be presented with the following dialog: 

 

 

Use the Getting Started dialog as a shortcut when getting started. You can create a New Project, or New Drawing.  

The drop-down at the top will change the Current Project. 

Switch to the Project Drawings tab for a list drawing associated with the Current Project.  

Note: right-clicking while in the Project Drawings tab drawings list will provide a context menu that allows you to display the drawings 
in list form, and unlock locked drawings. Holding the Shift or Ctrl keys allow multiple selection of Project Drawings. 

 

Drawing Icon Color Legend 

Green: Drawing found at specified path and available 
for use. 

 

Yellow: Drawing found at specified path and in use by 
another user.  

 

Red: Drawing not found at specified path. Possibly 
renamed or moved. 

 

Change the 
Current Project 

Create a New 
Project 

Create a New 
Drawing 

Open Current 
Project Drawings
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The Project Explorer  

 

This dockable form provides access to many 
functions allowing you to open and edit 
Global and Project Databases, Open and 
create New Drawings. Open and create New 
Reports, and most importantly select the 
current Project Database 

 

 

 

 

 

 

Start here to create new drawings 

View Drawings associated with this project 

 

Green icons indicate available drawings 

Red icons indicate missing drawings 

Yellow icons indicate drawings in use 

Create new reports 

Open existing reports 
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Selecting the Current Project Database  
Use the pull down combo box at the top to set the current project database.  

Note: the Personal version only has access to the Default Project. 

Global Databases 
Global Databases are those that are common to all projects. As follows: 

• Manufacturers 
• Equipment 
• Signal Types 
• Connectors 
• Cable Types 
• Jack Fields 

 

Project Drawings 
Create New Drawing  

 

Double-click this icon on the Project Explorer or  on the Standard toolbar. You will be prompted to 
select a WireCAD template drawing.  
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Template Drawings 
When you create a new drawing in WireCAD you are prompted to select from a number of template drawings. These drawings are 
prepared to receive input from WireCAD. The template drawings also provide a default layout for the ANSI drawing size indicated. To 
create your own templates, modify an existing template and save the drawing in the WireCAD3\TemplateDrawings folder. 

 

NOTE: You can customize a template drawing with all of your default company and project 
information. Then save the drawing into the \WireCAD3\TemplateDrawings folder and it will be 
available from this view. Now you will not have to enter redundant information and can insure 
symmetry between drawings. 
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Open Existing  

Click on the  folder in the Project Explorer or the  button on the Standard toolbar. This will launch an 
Open dialog: 

 

Browse to the location of the drawing and click Open. 

Any drawing that you open in WireCAD is automatically modified to include the WireCAD specific Layers, Blocks, and Text Styles. 

Associated Drawings 

Note: Any drawing opened in WireCAD is automatically associated with the current project in the drawings database. 
Additional fields are available for editing and reporting. 

Project Databases 

 

Open project databases in datasheet view including: 

• Project Systems: Listing of all systems associated with the Current Project. Systems are added to this database by double-
clicking on equipment in a drawing. 

• Project Cables:  Listing of all cables associated with the Current Project. cables are added to this database by double-
clicking on cables in a drawing. 

• Project Jack Fields/Jacks: Not Used in Version 3. Retained for backward compatibility. 
• Drawing Database: Pointers and meta-data to all drawings associated with the Current Project. Drawings are added to this 

database when they are opened in the Current Project. 
 

Reporting 

New Report: Create a new report definition file using the new Report Wizard.  

Generate Bill of Materials: WireCAD does not maintain a running bill of materials but generates the Bill of Materials on demand. 

Clicking this icon launches the Bill of Materials Wizard to create a new bill of materials or edit 
an existing one.  
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General Reports: Open an existing report definition file. To add a file to the General Reports list, place the .RPX file in the WireCAD 
Path\Reports\General\  

Labels: Open an existing Label definition file.  To add a file to the Labels list, place the .RPX file in the WireCAD Path\Reports\Labels\  

 

WireCAD 3 Levels Defined  
Level Multiple 

Projects 
Multiple 
Users 

Report 
Designer 

Unlimited 
Cables 

Unlimited 
Drawings 

Personal   X X X 

Professional X  X X X 

Enterprise X X X X X 
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WireCAD Projects 

 

Defined 
WireCAD organizes drawings and cable information on a project basis. This allows you to have multiple projects or installations. Each 
project has a separate set of cable numbers and system ID’s. Each project is organized into a series of folders on your local 
hard drive or on a network share. 

  

Project Explorer Show/Hide  
Click this button to show or hide the Project Explorer: 
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New Project  
Creating a new project in WireCAD creates a new folder with the project name in the directory of your choice and places two 
additional folders in that folder. As follows: 

 

This process simultaneously creates an entry in the projects database. 

Link to Existing Project  
In the event that you need to move a project, use the Link to Existing function to gain access to the data. This function assumes that 
you have moved the entire project folder to the new location. Browse to, and select the ProjectDB.mdb in the Project Databases folder 
to link to the project. 

Note: as part of the Link function, a copy of the global databases will be place in the WireCAD3\DBUpdates\ folder. When you re-
launch WireCAD, the program will synchronize with the new database and make available all of the equipment, signal types, 
connectors, cable types, etc. that were part of the incoming project.  

Consolidate and Move Project  
Use this function to consolidate all of the drawings associated with the project into the ProjectFolder\Drawings folder making it easier 
to move the drawings, and databases associated with a project. You will be given the chance to either Copy or Move the project 
drawings. Select Copy if you have drawings that are referenced by more than one project.  

Note: the Consolidate function also copies the current dbEquip.MDB database into the Project Databases folder. This allows you to 
easily move the entire project and to have all of the equipment that you created move with it. 
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Delete Project  
Selecting Delete presents two choices: 

 

Selecting Leave Drawing Files and Databases will remove the reference in the projects database and leave all drawings and 
databases in tact. This is the Default Mode. 

 

Selecting Delete Drawings and Databases will physically remove (DELETE) all drawings and databases associated with the current 
project. 

These operations cannot be undone. 
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Preferences  
Blocks Tab 

 

 

Use Default Block Names: Unchecked allows user editing of the block name. 

 

 

 

Automatically Generate System Aliases: Checked will use the system name as an alias if no alias is found. 

Display Block Preferences …: Checked displays this dialog when creating and equipment block. 

Colored Pins: Checked uses information from the Signal Types database to determine the color on block pins. 



 

 29

 

Cables Tab 

 

The following checkboxes preload the Draw Cables dock-able form: 

• Auto Repeat: Restarts the Draw Cables Function. 
• Auto Draw Pointers: Places linked pointers at source and destination pins based on Auto Place Distance. Use only for “On 

Sheet” pointers. 
• Auto Place: Places terminal gear (Jacks, Terminals, and Pointers) to the right or left of the source or destination based on 

the distance defined in the Auto Place Distance Field. 
• Auto Place Distance: See above. 

Confirm Cable Setting: Display the Verify Settings dialog for every cable assignment. Unchecked sends the default information 
directly to the database. 

Save Document After …:Saves the document after every assignment. 

Colored Cables: Uses information for the Signal Types database to set the color of the cable. 

Colored Cable Number …: Uses information for the Signal Types database to set the color of the cable number text. 

Warn of Signal Type Mismatch: Warns user every time the source and destination signal types don’t match. 

Default Cable Type: If the Signal Types database does not contain Cable Type information then this value will be assigned to a 
cable.  

Starting Cable Number: The starting cable number for every Cable Number Prefix. 
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General Tab 

 

 

String Formatting: Determines how text is formatted for certain fields in WireCAD. 

Create Layer…: Creates a new layer for each Signal Type following this form: 

  

Drawing Entity Layer Name 

Cable Polyline = SignalType 

Cable Number Text = SignalType_No 

Block Pin = SignalType_Pin 

 

Disable Warn on Delete: Checked disables the warning dialog when deleting an entity that has a reference to the database. 

How To Dialogs: Shows or hides the How To dialogs. 
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Support Paths 
This dialog exposes as series of support paths utilized by WireCAD: 

 

General Paths 
 Application Path (read only) 
  The current location of the WireCAD v3 application and folder. 

 Current Project Directory (read only) 
The location of the Current Project as selected from the Current Project drop-down 

 

 Equipment Database 
  The location of the dbEquip.mdb file. 

  Click on the ellipsis button (…) to edit the path to the file. 

 Project Manager Database 
  The location of the dbPM.MDB file. 

  Click on the ellipsis button (…) to edit the path to the file. 

 Blank Project Database 
The location of the blank project database. This database is copied to the new project location, and into the 
Project Databases folder whereupon it is renamed from BlankDB.MDB to ProjectDB.MDB. 

Click on the ellipsis button (…) to edit the path to the file. 
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Blocks Paths 
 Blocks Root Path: %BLOCKS% 

Defines the %BLOCKS% variable used by several of the WireCAD functions, including the BlockRef path function 
of the Equipment Library. This function provides for a relative path that is defined by %BLOCKS% variable.  

Click on the ellipsis button (…) to edit the path. 

 Jacks Directory: %JACKS% 
Defines the %JACKS% variable used by several of the WireCAD functions, including the Draw Cables function.  

Click on the ellipsis button (…) to edit the path. 

Terminals Directory: %TERMINALS% 
Defines the %TERMINALS% variable used by several of the WireCAD functions, including the Draw Cables 
function.  

Click on the ellipsis button (…) to edit the path. 

Pointers Directory: %POINTERS% 
Defines the %POINTERS% variable used by several of the WireCAD functions, including the Draw Cables 
function.  

Click on the ellipsis button (…) to edit the path. 
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Report Paths 
 General Reports 

The location of the General reports folder. The *.RPX files in this folder are enumerated in the Reports\General 

folder in the Project Explorer.  

  Click on the ellipsis button (…) to edit the path to the folder. 

 Cable Label Reports 
The location of the Label reports folder. The *.RPX files in this folder are enumerated in the Reports\Labels folder 

in the Project Explorer.  

  Click on the ellipsis button (…) to edit the path to the folder. 
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The Drawing Environment (CAD) 
WireCAD provides a rich set of drafting tools including many standard functions like: 

• Lines. 
• Polylines. 
• Circles. 
• Arcs. 
• Points. 
• Dimensions. 
• Text. 
• Images. 
• Blocks. 
• Viewports. 
• Attributes. 
• Extended Properties. 

 

DWG File Limitations 
While the WireCAD is able to open and create .DWG files, there are some limitations: 

Unsupported objects : 

• ACIS Objects. 
• 3D Solids. 
• Region. 
• Body.    
• MLine (MultiLines) WireCAD converts to single text objects.  
• Leader.   
• OleFrame. 
• Ray.   
• Rtext. 
• Shape.  
• Xline.  
• Dimension (we might have some differences from ACAD because we don't support Overwrite properties of ACAD dim style).  
• SHX and SHP files. We convert these to the closest TrueType Fonts.  
• We convert Hatch to PolyHatch Objects.  
• Dictionary - XRecord Objects (You can use XProperties). 
• Group of objects.  

Drawing Spaces, Layouts, and Viewports 
The DWG file format has two drawing spaces – Model space – where you draw your model one to one scale. Paper Space – where 
you layout the drawing for print. The Paper Space can be explained as follows: imagine a sheet of paper inserted between you and 
your model. In order for you to see your model you will need to cut a Viewport through you paper to see the model.  This is done using 

the Create Viewport function from the View menu or toolbar  WireCAD supports the ACAD 2000 convention of multiple Paper 

Spaces or Layouts. Use the Layout Manager  on the View Toolbar. 

 

Note:  

Saving the document down to R-14 or lower will remove any layouts from the drawing file—leaving a 
single Paper Space. 
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Printing  
Printing: The document size will be based on the current system printer paper size. 

 

  

Pen Assignments 

  

Assign different pen widths to different colors based on color number. Select a Color number and enter a value in the Width textbox. 

Pick > 
Pick window to print. 

Window/Extents 
Print the extents or pick a window to print. 

Orientation 
Change the orientation between Portrait and Landscape. 

 

Plot Margins 
Enter the margins in MM or Inches. 
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Scale and Color 
Scale the window to the paper size, and set print in black and white. 

 

Select Printer 
Select a printer and change its properties. 

 

Refresh 
Updates the print preview window. 
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Drawing Format Dialogs 

 

 

Layers  
Layer is the equivalent of the overlay used in paper-based drafting. It is the primary organizational tool in WireCAD, and you can use it 
to group information by function and to enforce linetype, color, and other standards.  

 
Organizing Layers and the objects on Layers make it easier to manage the information in your drawings. When you put one layer over 
another then the result is the complete drawing. 

 

 

There is no limit to the number of layers you can place in a drawing.  

When you begin a new drawing, WireCAD creates a special layer named 0. By default, layer 0 is assigned color number 7 (white or 
black depending upon your background color), the CONTINUOUS linetype and a lineweight of Default (the default setting is .01 inch 
or .25 mm). Layer 0 cannot be deleted or renamed.  

All new objects are added to the active layer if no layer is specified. 

Using WireCAD you can Freeze (Hide), Thaw (Show) and Lock layers. 

By controlling whether a Layer's state is Thaw or Frozen you can change the appearance of your drawing to display only the 
information on the Layers that are visible. Freezing unused Layers will help the performance of WireCAD 

 

In the drawing below (Picture 1) there are 3 types of items: walls (the lines and Polylines with red color), doors&windows (Blue 
color) and furniture (Magenta). 

 
These objects are teamed and drawn in different layers. Walls placed on layer "WALLS", Doors&windows are placed on layer 
"WIN_DOORS" and furniture are placed on layer "FURNITURE". 
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Picture 1 
 

All layers are Thawed. All information is shown.  
In big drawings this might confuse the user.  

 

 

Picture 2 
 

Layer "FURNITURE" is Frozen. The furniture is not shown. 
A civil engineer would like to view the drawing this way. 

 

Picture 3 
 

All layers except the "WALLS" are Frozen. 
This is the basic information.  

 

 

 

 

 

 

WireCAD Specific Layers 
WireCAD requires a specific set of layers in order to operate properly. These layers are added automatically if you open a drawing file 
in WireCAD. A list of the necessary layers is available in the appendix. WireCAD will also create a series of layers for each signal type 
that is added to the drawing. As Follows: 
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Drawing Entity Layer Name 

Cable Polyline = SignalType 

Cable Number Text = SignalType_No 

Block Pin = SignalType_Pin 

 

The Layers Dialog  allows you to Freeze(hide) and Thaw(show) various layers.  

Note: WireCAD will not allow the current layer to be frozen. 

 

Freeze 
Hide the selected layer. Frozen layers will not be included in selection sets for deletion. 

Thaw 
Show the selected layer. 

Color 
Set the color for entities on the layer with their color property set to Same as Layer. 

Line Type 
Set the Line Type for entities on the layer with their Line Type property set to Same as Layer. 

Lock 
Lock the layer so that it cannot be edited. 

Unlock 
Unlock the layer allowing editing. 
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Text Styles  
Text Styles are a way of organizing groups of text together and defining a font and default characteristics for the style.  

WireCAD requires several Text Styles be in the drawing document in order to operate properly. These Text Styles are added to a 
document if it is opened in WireCAD. These Text Styles are enumerated in the appendix. 

 

The text styles associated with WireCAD allow the user to customize the appearance of equipment blocks and cables within a drawing 
document. 
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Dimension Styles  
The active dimension style determines the appearance of new dimensions created in the drawing. To change the style of an existing 
dimension, use the StyleName property found on the dimension.  

When you create a dimension, the current dimension style is associated with that dimension. The dimension retains this dimension 
style unless you apply a new dimension style to it or set up dimension style overrides.  

 

Customize dimension styles.  

Add new, and edit existing dimension styles. Arrow blocks can be added to the drawing using the Insert Block functions. 
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Point Styles  
Set the Point Styles for the drawing. 

These settings will apply to all points in the drawing. 
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Layouts Dialog  
Default Keyboard Shortcut: SO 

Display the layouts dialog. Here you can add, edit and delete layouts. 

The DWG 2000 file format provides from multiple paper spaces call Layouts. This dialog provides access to these functions.  

Note: Creating more than one Paper space and then saving the DWG file back to R14 or earlier will cause the additional layouts to be 
deleted from the saved file. 
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The Properties Window 

 

Clicking on a property in this window displays a description in the window below the properties.  

 

Enter values directly or use the pull down buttons to open enumerations or dialogs depending on the property. This window applies to 
the following: 

• Drawing properties. 
• Drawing entity properties. 
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• Report designer properties (See the Report Designer Section). 
Depending on the property, the property window will accept input in one of the following formats (data types): 

Format Range Example 

String Alphanumeric Hello World 1234 

Coordinate  HorizontalDouble, 

VerticalDouble 

1,1 will locate a vertex at 1 
drawing unit away from the 
horizontal and vertical 
origins. 

Double -1.79769313486231E308 to -
4.94065645841247E-324 for 
negative values and from 
4.94065645841247E-324 to 
1.79769313486232E308 for positive 
values 

1.234567 

Integer Depends on the property Colors range from 0-255. 

Path Windows long path C:\Program files\WireCAD2. 
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General Drawing Properties 
The WireCAD drawing environment supports many different environment variables. These are available by pressing the  button on 
the View toolbar. In order to expose the general properties, be sure that no entities in the drawing are selected before pressing the 
properties button. 

The following is a list of the general drawing properties: 

Property Style/Value 
Range 

Description 

Document Settings 

Active Layer Dropdown / Enum Sets the current layer. Use the Layers Dialog to 

define layers . 

Angular Units Dropdown / Enum Sets the Angular units for the drawing. 

Angular Units Precision Dropdown / Enum Sets the number of decimal places for Angular 
units. 

FileName Read Only Returns the name and path of the drawing file. 

FileVersion Read Only Returns the current file version. 

Grid Mode Boolean Toggles the display grid. 

Grid Space  Direct Entry / 
Double (x,y) 

Sets the display grid spacing. 

Linear Units Dropdown / Enum Sets the Linear units for the drawing. 

Linear Units Precision Dropdown / Enum Sets the number of decimal places for Linear 
units. 

Line Type Scale Direct Entry / 
Double 

Sets the scale for all line types in the drawing. 

Ortho Mode Boolean Toggles the orthogonal (right angle) snap mode. 

Snap Mode Boolean Toggle the Snap to Grid mode. 

Snap Space Direct Entry / 
Double. (x,y) 

Sets the snap spacing. Note: the snap spacing 
can differ from the Display grid spacing 

Active Pen 

Active Pen Color Dialog / 0-255 Sets the current color to draw entities: 

 

Active Pen Style Dropdown / Enum Sets the current line type for entities to be 
drawn. 

Penstyle is scaleable. The scale is set from 
the LineTypeScale property. 

TIP: Instead of changing line type every 
time you want a different line type, you can 
create different layers with the desired line 
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type. 

 

Active Pen Width Direct Entry / 
Double 

Sets the line width for entities to be drawn. 

Active Fill 

Active Fill Background 
Color 

Dialog / 0-255 Sets the background color for filled entities. 

Active Fill Color Dialog / 0-255 Sets the color for filled entities. 

Active Fill Mode Dropdown / Enum Sets the hatch type for filled entities. 

Active Text 

Text Style Dropdown / Enum Sets the active Text Style. 

Text Height Direct Entry / 
Double 

Sets the default text height. 

Hor Justify Dropdown / Enum Sets the horizontal text justification. 

Ver Justify Dropdown / Enum Sets the vertical text justification. 

Drawing Limits 

X Min Direct Entry / 
Coord 

Sets the lower left X corner of the grid. 

X Max Direct Entry / 
Coord 

Sets the upper right X corner of the grid. 

Y Min Direct Entry / 
Coord 

Sets the lower left Y corner of the grid. 

Y Max Direct Entry / 
Coord 

Sets the upper right Y corner of the grid. 

Environment Variables 

Background Color Dialog / 0-255 Sets the background color of the display. 

Crosshair Size Direct Entry / 
Double 

Sets the size of the crosshair. 
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Set to 2000 or so for a full-field crosshair. 

GripColor Dialog / 0-255 Sets the grip color. 

 

 

Grip Size Direct Entry / 
Double 

Sets the grip size. 

Mouse Wheel Reversed Boolean Reverses the default behaviour of the Mouse-
Wheel.  

Osnap Color Dialog / 0-255 Sets the color of Object Snap grips 

Pick Size Direct Entry / 
Double 

Sets the size of the square at the center of the 
cursor. 

Show Layouts Tabs Boolean Toggles the display of the layout tabs at the 
bottom of the drawing space. 

ShowWCSAxis Boolean Toggles the display of the WCS Axis: 
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Entity Specific Properties 
General Properties 
Every WireCAD drawing entity shares some general properties they are as follows: 

Property Style/Value Range Description 

Area Read Only Displays the area of the entity. 

Handle Read Only Displays the entity’s handle. This identifier 
will last for the life of the entity. 

Label Direct Entry / String User definable field associated with entity. 

Layer Dropdown / Enum Sets the layer that the entity is associated 
with. 

Line Type Scale Direct Entry / Double Sets the scale of the LineType associated 
with the entity. 

Pen Color Dialog / 0-255 Color dialog to set the color of the entity: 

 

Pen Style Dropdown / Enum Set the line type used for the entity. 

Pen Width Direct Entry / Double Sets the pen width for the entity. 

Has Extended Data Read Only / Dialog Displays a count of the extended data 
items associated with the entity. Note: This 
dialog is read only. 

 

 

Line Properties: 
Property Style/Value Range Description 

End Point Direct Entry / Coord The end point vertex of the line. 

Start Point Direct Entry / Coord The start point vertex of the line. 

 

Polyline Properties: 
Property Style/Value Range Description 

Hatch Block Direct Entry / Path Path to block file to use as hatch for filled 
titi



 

 50

entities. 

Fill Block Scale Direct Entry / Double Scale value. Used when the Fill Mode is 
set to 11-HatchBlock and the Hatch Block 
property is not null.  

Fill Background Color Dialog / 0-255 Sets the background color for filled entities. 

Fill Color Dialog / 0-255 Sets the color for filled entities. 

Fill Mode Dropdown / Enum Sets the hatch type for filled entities. 

 

Point Properties: 
Property Style/Value Range Description 

None   

 

Circle Properties: 
Property Style/Value Range Description 

CenterPoint Direct Entry / Coord Sets the center point vertex of the circle. 

Radius Direct Entry / Double Sets the radius of the circle. 

Hatch Block Direct Entry / Path Path to block file to use as hatch for filled 
entities. 

Fill Block Scale Direct Entry / Double Scale value. Used when the Fill Mode is 
set to 11-HatchBlock and the Hatch Block 
property is not null.  

Fill Background Color Dialog / 0-255 Sets the background color for filled entities. 

Fill Color Dialog / 0-255 Sets the color for filled entities. 

Fill Mode Dropdown / Enum Sets the hatch type for filled entities. 

 

Arc Properties: 
Property Style/Value Range Description 

CenterPoint Direct Entry / Coord Sets the center point vertex of the arc 

Radius Direct Entry / Double Sets the radius of the arc. 

Hatch Block Direct Entry / Path Path to block file to use as hatch for filled 
entities. 

Fill Block Scale Direct Entry / Double Scale value. Used when the Fill Mode is 
set to 11-HatchBlock and the Hatch Block 
property is not null.  

Fill Background Color Dialog / 0-255 Sets the background color for filled entities. 

Fill Color Dialog / 0-255 Sets the color for filled entities. 

Fill Mode Dropdown / Enum Sets the hatch type for filled entities. 

 

Rectangle Properties: 
Property Style/Value Range Description 

Area Read Only Displays the area of the rectangle. 

InsertionPoint Direct Entry / Coord The insertion point vertex of the rectangle. 

Hatch Block Direct Entry / Path Path to block file to use as hatch for filled 
entities. 
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Fill Block Scale Direct Entry / Double Scale value. Used when the Fill Mode is 
set to 11-HatchBlock and the Hatch Block 
property is not null.  

Fill Background Color Dialog / 0-255 Sets the background color for filled entities. 

Fill Color Dialog / 0-255 Sets the color for filled entities. 

Fill Mode Dropdown / Enum Sets the hatch type for filled entities. 

 

Text Properties: 
Property Style/Value Range Description 

Height Direct Entry / Double Sets the text height. 

HorJustify Dropdown / Enum Sets the horizontal justification 

InsertionPoint Direct Entry / Coord Sets the insertion point for the text. 

Rotation Direct Entry / Degrees Sets the rotation in degrees for the text. 

 

 

Image Properties: 
Property Style/Value Range Description 

Display Dropdown / Enum Sets the display properties of the image. 

Height Direct Entry / Double Sets the height in drawing units of the 
image. 

InsertionPoint Direct Entry / Coord Sets the insertion point vertex of the 
image. 

Width Direct Entry / Double Sets the width in drawing units of the 
image. 
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Insert Properties: 
Property Style/Value Range Description 

Area Read Only Displays the area of the entity. 

Has Attributes Boolean/Dialog Displays the number of attributes 
associated with the block. Clicking the … 
button activates the Edit Attributes dialog: 

 

 

 

 

 

Block Name Read Only Displays the name of the block. 

Insertion Point Direct Entry / Coord Sets the insertion point vertex of the insert. 

Insert Rotation Direct Entry / Degrees Sets the rotation in degrees for the insert: 

 

Scale Direct Entry / Double Sets the scale of the insert. 

 

WireCAD Specific Entities Properties: 
Property Style/Value Range Description 

XProperties Read Only Displays the extended properties for an 
entity. All WireCAD specific entities 
(equipment blocks, cables, terminals, etc.) 
have a specific set of extended properties. 
These help define the functions, 
associations, and database links of 
WireCAD specific entities. 
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Entity Selection 
When you run an edit command (which allows multiple object selection) you have to select the objects (or object) that you want to edit. 

There are three ways to select objects: 

• Click on the entity: You can add or remove entities to your selection set by holding the Shift key while clicking on an entity. 
Clicking on a entity that has already been added to a selection set will remove it (if the Shift Key is pressed).  

• Crossing Window: Selection windows that are drawn from Right-to-Left will appear dashed indicating a Crossing window. 
Any entity that intersects with, or is wholly contained within, the selection window will be included in the selection set. In the 
example below, both the line and the circle will be added to the selection set. The circle because it is wholly contained in the 
Crossing window and the line because it intersects with the Crossing window. 

  

 

• Containing Window: Selection windows that are drawn from Left-to-Right will appear solid indicating a Containing 
window. Any entity that is wholly contained within the window will be included in the selection set. Entities that merely 
intersect with, but are not wholly contained within the window will by excluded. In the example below the only entity that is 
wholly contained within the window is the circle. Therefore it is the only entity to be added. 
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Tools  

 

 

Draw Line  
A single Line segment. 

Lines can be one segment or a series of connected segments, but each segment is a separate line object. 

 

Default Keyboard Shortcut: DL 

After you start the command, follow the command line prompts for picking each point that defines the object. As you draw, you can: 

Left-click to finish one line segment and begin another, connected segment. 

Finish the line: Right-click or press enter. 
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Draw Polyline  
This object is a 2D line composed of line and arc (bulges) segments. Polyline is specified by an array of Vertexes (points). 

 

 

 

Bulge Geometry: 
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Default Keyboard Shortcut: DP 

Draw a two-dimensional polyline, consisting of one or more straight line segments or arc segments connected at vertices. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Left-click to finish one polyline segment and begin another, connected segment. 

Finish the line: Right-click or press enter. 

 

Draw Point  
Create a point entity based on the global point settings. 

Default Keyboard Shortcut: DP 

Draw a single point object. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Left-click to finish the point. 

Exit: Right-click or press enter. 

 

Draw Circle  
A full circle is defined by its CenterPoint and its Radius. 

 

Default Keyboard Shortcut: DCC 

Draw a circle defined by center point, then radius. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Finish the circle: Right-click or press enter. 
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Draw Ellipse  
Draw an Ellipse by defining its Center, Major Angle (Axis 1), and Minor Length (Endpoint).  

 

 

Default Keyboard Shortcut: NONE 

After you start the command, follow the Command Line prompts for picking each point that defines the object.  

Finish the Ellipse: Right-click or press enter. 



 

 58

 

Draw Arc  
A circular arc is defined by the center point, the radius, the start angle and the end angle. 

An arc is always drawn anti-clockwise from the StartAngle to the EndAngle. 

The StartPoint and EndPoint properties of an arc are calculated through the StartAngle, EndAngle and Radius properties. 

 

Default Keyboard Shortcut: DCC 

Draw an arc defined by center point, then radius, then angle. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Finish the arc: Right-click or press enter. 

 

Draw Rectangle  
The rectangle is defined by InsertionPoint, Rotation, Width and Height. 

 

Default Keyboard Shortcut: DR 

Draw a rectangle defined by upper left, then lower right coordinates. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Finish the rectangle: Right-click or press enter. 

 

Draw Text  
Text is defined by start point where the text will begin, the rotation angle of the text, and the text string. Notice that the text will be 
drawn with the current Text Style of the document. 

 

Default Keyboard Shortcut: DT 

Draw text defined by basepoint coordinates, then rotation, then text string. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 
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Finish the text: Right-click or press enter. 

 

Draw Image  
A basic object for inserting images in the drawing. 

Inserted Images can be BMP, GIF, JPG, PNG and TIFF  

When the inserted image is an 1-bit Image (B&W) then the background color of the image (usually the white) is shown transparent 
and the other color is shown black or white, depending on the background color. This is useful for drawings to be scanned and 
then inserted as images in other drawings. 

Image has a Scale property that is used to resize keeping the aspect ratio of the image.  

The image is defined by InsertionPoint, Rotation, Width and Height. 

 

Default Keyboard Shortcut: DI 

Draw an image defined by basepoint coordinates, then selecting an image file to link to. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the image: Right-click or press enter. 
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Dimensions  

 

 

Dimensioning is the process of adding measurement annotation to a drawing. User has many ways to dimension objects and many 
ways to format dimensions. You can create dimensions for a wide variety of object shapes in many different orientations. You can 
create dimension styles to format dimensions quickly and ensure that dimensions in your drawing conform to industry or project 
standards.  

Dimensions show the measurements of objects, the distances or angles between objects, or the distance of a feature from an origin 
you specify. User has three basic types of dimensioning: linear, radial, and angular. Dimensions can be horizontal, vertical, aligned, 
rotated, angular. A linear dimension measuring the distance between two points which is displayed parallel to the points  being 
measured. In aligned dimensions, the dimension  line is parallel to the extension line origins. The extension  line origins are specified 
using the DefPoint1 and DefPoint2 properties.  

 
 

 

 

 

 

Draw Aligned Dimension  
Default Keyboard Shortcut: DDA 

Draw an aligned dimension. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the aligned dimension: Right-click or press enter. 
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Draw Horizontal Dimension  
Default Keyboard Shortcut: DDA 

Draw a horizontal dimension. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the horizontal dimension: Right-click or press enter. 

 

Draw Vertical Dimension  
Default Keyboard Shortcut: DDA 

Draw a vertical dimension. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the vertical dimension: Right-click or press enter. 

 

Draw Radius Dimension  
Default Keyboard Shortcut: DDA 

Draw a radius dimension. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the radius dimension: Right-click or press enter. 

 

Draw Diameter Dimension  
Default Keyboard Shortcut: DDA 

Draw a diameter dimension. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the diameter dimension: Right-click or press enter. 

 

Draw Angular Dimension  
Default Keyboard Shortcut: DDA 

Draw a diameter dimension. 

After you start the command, follow the Command Line prompts for picking each point that defines the object. As you draw, you can: 

Enter data directly in the command line. 

Finish the diameter dimension: Right-click or press enter. 
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Modifying Drawing Entities 

 

 

Delete  
With the delete command you can delete one or more objects of the drawing. 

If you want to erase multiple objects you have to execute the select method. 

After the delete command, the objects no more "exist" in the document and in the collection they belonged to, however the objects still 
exist as "deleted" objects in memory. So with undo command you can get them back to the drawing. 

Default Keyboard Shortcut: The DEL Key 

Delete Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Copy  
With copy command you can copy one or more objects of the drawing. 

When copy command starts, you will be prompted to select the objects to copy. Next you will be prompted to select two points. These 
two points define the "copy vector" and can either belong to the selected objects or not. The first point specifies the begining of the 
"copy vector" and the second point the end of it. 

 

Default Keyboard Shortcut: MC 

Copy Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 
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Move  
With move command you can move one or more drawing objects. 

Select the objects to move and define two points that define the distance and the direction of the movement. 

The first point defines the beginning of the "movement vector" and the second the end of the vector. 

 

Default Keyboard Shortcut: MM 

Move Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

Scale  
With scale command you can increase or decrease the size of one or more objects. 

First you have to select one or more objects. Then you have to pick one point, which is going to be the base point. Next step is to 
specify the scale factor. You can either type or pick this value from the drawing. 

 

Default Keyboard Shortcut: MS 

Scale Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Rotate  
With rotate command you can rotate one or more objects around a base point. 

First you have to select  the object or objects and then specify the base point. Then select an angle in degrees to rotate the object. 

  

 

Default Keyboard Shortcut: MR 

Rotate Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 
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Mirror  
With mirror command you can create the symmetrical of one or more objects reflected by an axis defined by the user. 

First, select the objects you want to mirror. Next, set the axis by setting the first point of mirror line and then the second. At this point 
you have to choose if the source objects will be deleted or not. 

 

 

Default Keyboard Shortcut: MS 

Mirror Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

Stretch  
Default Keyboard Shortcut: MS 

Stretch Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

Explode  
With explode command you can break compound objects such as: inserts, dimensions, and polylines into their sub entities. 

 

Default Keyboard Shortcut: MDA 

Explode Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 



 

 65

 

Trim  
With trim command you can trim objects at a cutting edge defined by other objects. 

 
First select the objects that define the cutting edges at which you want to trim an object and then the object.  
Objects that can be trimmed include arcs, circles, elliptical arcs, lines. 

Notice that the trim command does not function if the objects do not intersect.  

At the example below there are some lines that were trimmed. 

 

 

Default Keyboard Shortcut: MT 

Trim Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Extend  
With extend command you can extend lines, arcs, polylines until they intersect with some other object which is used as the limit of the 
extension. 

First, select the objects that define the limits of the extension. Then you have to choose a point on an object that you want to extend. If 
the object you want to extend does not intersect with above objects then nothing will happen. 

 

 

Default Keyboard Shortcut: ME 

Extend Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 
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Fillet  
Insert fillet arcs at vertexes of specified index of a polyline where two line segments meet if the specified radius is enough small to fit 
into lines. 

If the radius is bigger then it is ignored for the specific vertex. 

 

 

Default Keyboard Shortcut: ME 

Fillet Selected Polyline Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Corner  
Use the corner function to either extend two lines to their intersection or to erase lines that extend past their intersection. 

Note: only applies to Line entities. 

 

 

Default Keyboard Shortcut: MN 

Corner Selected Line Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 
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Offset  
With Offset command you can create a new object in parallel direction and at a specified distance from the original object that is used 
as pattern for the new object. 

When you execute offset command, you are prompted to select an object. Then you have to specify the offset distance. This is the 
distance that the new object will be draw from the original object. Then you have to set the side that the object will be draw because 
there are two sides. 

 

 

Default Keyboard Shortcut: ME 

Fillet Selected Polyline Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Break  
With break command you can divide one object into two objects, or you can remove one part of it (this part will be defined by two 
points that you have to pick). 

First you have to select the object. Next, define the first break point and the second break point. When you pick these points the part 
defined by the two points will be deleted from the object.  

The two points can be the same point. In this case you only explode the object into two other objects (for example you can cut a line 
into two lines). 

If break command involves a circle, you must define two different points in order to see a result because a circle cannot break in one 
point. After break command the circle becomes arcs. 

 

Default Keyboard Shortcut: MB 

Break Selected Entities. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Array  
Creates multiple copies of objects in a rectangular pattern.  

With the rectangular array you can create an array defined by a number of rows and columns of copies of the selected object. First, 
select the objects. Then  define number of rows and number of columns of the rectangle, the distance between rows and the distance 
between columns. 

 

Default Keyboard Shortcut: MA 

Array Selected Entities. 
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Use this form to determine the number of rows and columns in the array, and set the distance between the rows and columns. 

Clicking on the   button allows you to determine the distance by selecting points in the drawing. See example below. 

 

 

To create an array of entities, select the entities to include. Here we will create a 2 x 2 array of the selected circle: 

 

Next click on the  button. 

Here we enter the number of rows and columns, and determine the distance between each row and column.  

Note:  

When creating an array, always include the starting row and column. So the number entered in 
the rows and columns field is the total number of rows and columns. 
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Clicking OK yields the following: 

 

 

Bring to Front  
Default Keyboard Shortcut: MB 

Bring Selected Entities to the front. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

 

Send to Back  
Default Keyboard Shortcut: MB 

Send Selected Entities to the back. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 
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Viewing, Panning, Zooming 

 

 

Zoom In  
Zoom In command allows the user to increase  the apparent size of objects , so the user can control the part of the drawing that is 
included in the screen. 

Note: Zoom In command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: ZI 

Zoom into the drawing by 5 percent. 

Alternately use the mouse-wheel. 

Zoom Out  
Zoom Out command allows the user to decrease  the apparent size of objects , so the user can control the part of the drawing that is 
included in the screen. 

Note: Zoom Out command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: ZO 

Zoom into the drawing by 5 percent. 

Alternately use the mouse-wheel. 

Pan  
You can shift the location of your view by using  pan or by using the window scroll bars. Like panning with a camera, pan does not 
change the location or magnification of objects on your drawing; it changes only the view.  

Note: Pan command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: VP 

Pan the drawing. 

Alternately, hold the mouse-wheel down and move the mouse to pan the drawing view. 
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Zoom Window  
Zoom Window command allows the user to increase  the apparent size of objects using a selection window, so the user can control 
the part of the drawing that is included in the screen. 

Note: Zoom Window command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: ZW 

Select a window to zoom to. 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

Zoom Extents  
Zoom Extents command Zooms to display the drawing extents. 

Note: Zoom Extents command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: ZE 

Zoom to the extents of all drawing entities. This will zoom to show all entities in the current drawing space. 

 

Zoom All  
Zoom All command zooms to the drawing limits or current extents, whichever is greater. 

Note: Zoom All command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: ZA 

 

Zoom Last View  
Zoom Last View command Zooms to display the previous view. 

Note: Zoom Last View command is a transparent command. 

Transparent commands are commands that can be invoked when another command is active. 

 

Default Keyboard Shortcut: ZL 

Switch to the last view in the current drawing space. 
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Zoom Scale  
Opens the Zoom Scale dialog. Values entered here will cause the entities in the selected Viewport to display relative the the height of 
the selected Viewport. This function is useful for producing a final scaled output of an architecthural or mechanical drawing.  For 
example, entering 2 doubles the apparent display size of any objects from what it would be if you were zoomed to the limits of 
the drawing. Entering 0.5 causes each object to be displayed at half its current size on the screen, or relative to the height of 
the current Viewport, depending on the option selected. 

Default Keyboard Shortcut: NONE 

 

 

Regenerate Drawing  
Default Keyboard Shortcut: ZE 

Regenerate the entire drawing. 

Layouts Dialog  
Default Keyboard Shortcut: SO 

Display the layouts dialog. Here you can add, edit and delete layouts. 

The DWG 2000 file format provides from multiple paper spaces call Layouts. This dialog provides access to these functions.  

Note: Creating more than one Paper space and then saving the DWG file back to R14 or earlier will cause the additional layouts to be 
deleted from the saved file. 
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Create Viewport  
Create new Viewport entity in the current Paper Space or Layout. Viewports allow you to view through the Paper Space to the Model 
Space. 

Default Keyboard Shortcut: None 

Note: Only active when the current layout is not Model Space.  

 

Activate Viewport  
Activate the selected Viewport for Panning and Zooming. Once active, you can use any of the panning, zooming, or zooming scale 
functions. 

Default Keyboard Shortcut: None 

Double-click a Viewport to activate / deactivate. 

Note: The cursor will be constrained to the Viewport when the Viewport is Active.  
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Blocks and Inserts 

 

 

Defined 
Blocks represent logical groupings of drawing entities stored together within a drawing. Blocks may contain any drawing entity or 
entities. Blocks are created by selecting a group of entities and defining a base-point for re-insertion. 

 

Blocks may be written out of the drawing (creating a new drawing file) using the Write Block function  

Blocks can also be inserted multiple times in the drawing  This function displays the Inserts dialog (see below).   

Other drawings may be inserted into the current drawing.  

Other drawings may be externally referenced (Xref)  or linked to the current drawing. This allows the drawing to be maintained 
elsewhere and updated remotely. The changes can then be updated in the current drawing. 

 

 

An insert is a single instance of a block. A single block definition may have multiple inserts within the drawing. Take, for example, the 
case of a door block. The block is comprised of a straight line and an arc. These entities are grouped together and a base point is 
defined at the hinge point using the Tools>Insert>Create Block. Once the door block is defined, inserts of the block will be placed 
throughout the drawing as needed. This saves the user the tedious task of recreating the door entities every time a door is needed. 

Use the Blocks Dialog to place inserts in the current drawing space. 
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Creating New Blocks  
Tools>Inserts>Create Block 

After you start the command, follow the Command Line prompts to complete the command. 

Escape or right click to exit. 

You will be prompted to select the entities to include in the block. Select the entities. Next, right-click to continue. You will be prompted 
to select the base point or the insertion point of the block. This is the point from which an insert of this block with be placed 

Text Versus Attributes 
A block may contain Text entities, as well as a special type of text entity called an Attribute. Attributes are unique in that they may 
contain insert specific information. Attributes maintain data in TAG/VALUE pairs. The tag is used to identify the data contained in the 
value.   

Attributes may be defined as visible or invisible.  

To use our door block example from above. Say we define an Attribute  to group along with the line and arc. We designate the 
TAG as DoorNo and we enter DOORNO in the value field, and we set the visible value to true in order to display the attribute value 
upon block insertion. We then create our new door block and insert an instance of it in our drawing.  

 

 

Next we edit the attributes of the door insert by highlighting the door insert and clicking Tools>Inserts>Edit Attributes  or by 
pressing the ellipsis (…) button  

 

on the Has Attributes line of the properties dialog. We change the value to 101 to indicate that this is door number 101 and click OK 
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Our insert now displays the insert specific data as follows: 
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Externally Referenced Drawings (Xref)  
WireCAD v3 provides the ability to externally reference another drawing or drawings within the current drawing. Launching this 
function will display the Xref Manager dialog. From this dialog you can attach, detach, reload, and manage the layers of externally 
referenced drawings. 

 

Functions: 

Attach Xref 

Browse  to the drawing file. Determine the Placement, Scale and Rotation. Click OK to attach to the specified 
file. 

Detach Xref 
A list of currently attached Xrefs will be displayed. Select the one to detach. Click OK to detach the specified file. 

Reload Xref 
A list of currently attached Xrefs will be displayed. Select the one to reload. Click OK to reload the specified file. 

Manage Xref Layers 
A list of currently attached Xrefs will be displayed. Select the one to manage. Click OK to display a Layers dialog for the 
specified file. 

 

 



 

 78

The WireCAD Equipment Library 
Adding Equipment to Drawings  
Open the Equipment Library and use the Create Block function. 

Equipment 
The Find Equipment Tab 
 

 

  
The Find tab allows you to search the Equipment database, narrow your search parameters using the Industry Sector, and Search 
Field drop-downs. The default search will be conducted on all Industry Sectors using the EquipmentName field.  

Note that unlike WireCAD v2, Manufacturer names will not appear in this list until you have associated equipment with them. 

Copy Equipment Definition function 
This function assumes that you have a source equipment definition and that you have added the destination equipment to the library.  

To copy the entire definition from an existing piece of equipment: 

1. Select the equipment to copy from (source) and while holding the Alt key drag the selection to the destination equipment. 

2. During the drag operation the current destination will be highlighted in green. See below. 

3. Drop the source equipment on the destination equipment.  

4. You will be prompted to select whether to copy the Inputs and Outputs. Selecting Yes will copy the Inputs and Outputs from 
the source equipment into the destination equipment appending them to the table. 

5. You will then be prompted to whether to copy the Equipment Data. This is the physical data for the source equipment. 
Selecting Yes will overwrite any existing equipment data for the destination equipment. This function cannot be undone. 
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Equipment Data Tab 
 

 

 

This is where you enter the physical data for the piece of equipment. 

The following table illustrates each field and its associated properties: 

Field Name Description Attributes 

ManufacturerName The Manufacturer Name Read Only 

EquipmentName The Model Name or 
Number 

Read Only 

EquipmentDescription Description Editing Allowed 

EquipmentType SysName Prefix Field Editing Allowed 

EquipmentWeight Weight Quantity Editing Allowed 

EquipmentWeightValue Weight Value. i.e. 
pounds, kilos, etc. 

Editing Allowed (Pull Down List) 

EquipmentHeight Height Quantity Editing Allowed 

EquipmentHValue Height Value. i.e. Rack 
Units, Inches, 
Centimetres. 

Editing Allowed (Pull Down List) 

EquipmentWidth Width Quantity Editing Allowed 

EquipmentWValue Width Value. i.e. Inches, 
Centimetres. 

Editing Allowed (Pull Down List) 

EquipmentDepth Depth Quantity Editing Allowed 
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EquipmentDValue Depth Value. i.e. Inches, 
Centimetres. 

Editing Allowed (Pull Down List) 

EquipmentPower Power Consumption 
Quantity 

Editing Allowed 

EquipmentPValue Power Consumption 
Value. i.e. Watts, VA, 
KVA 

Editing Allowed (Pull Down List) 

EquipmentVotlage Voltage Quantity Editing Allowed 

EquipmentVValue Voltage Value. i.e. AC, 
DC 

Editing Allowed (Pull Down List) 

Vendor1, 2 Vendor Name Editing Allowed 

Cost1,2 Cost associated with 
vendor 1 and 2 

Currency, Editing Allowed 

BlockRef External CAD Block 
Reference 

Path to an external block that presents the 
physical parameters of this device. 

 
Image External Image File 

Reference 
Not yet Implemented 

Category Categorical search field Editing Allowed. Use commas to separate 
categories. 

IndustrySectors Industry sectors that this 
equipment touches 

Drop down form populated from the 
IndustrySectors Global 
Database.

 
Synomyns Synonym search field Editing Allowed. Use commas to separate 

categories. 
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Inputs and Outputs Tab 
 

 

 
The Input/Output (I/O) section is comprised of:  

• Inputs and Outputs lists.  
• Search Buttons.  
• Select All.  
• Clear Selections.  
• I/O Adder.  
• Update Preview. 
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The Input/Output tab is where the bulk of the work takes place; use the Equipment Library Input/Outputs 
tab to: 

• Add Inputs and Outputs. 
• Add multiple Inputs, Outputs or both to the I/O lists with a single operation. 
• Copy Inputs to Outputs and vice versa. 
• Edit or Delete Inputs or Outputs. 
• Search the lists to select specific Signal Types. 
• Select the Inputs, Outputs, or both to use when creating Equipment Blocks. 

Input/Output lists 

 
 
The Input and Output lists provide several functions. Not only are the inputs and outputs displayed but you 
can also edit any of the information displayed.  

To select an Input for display in an equipment block, simply select the box to the left of the Name. To select 
multiple I/O, hold the Ctrl or Shift key while selecting additional I/O.  

Press the Select All  button to select all of the I/O.  

Press the Clear Selections  button to de-select all I/O. 

Press the Update Preview  button to send changes to the preview display. 

 

Copying Inputs to the Outputs Table 
To copy selected inputs to the outputs table:  

1. Select the desired Inputs. 

2. While holding the Alt key, drag the selection to the Outputs table. 

3. Drop the selection on the Outputs table. 

The selected inputs will be copied to the Outputs table. 
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Copying Outputs to the Inputs Table 
To copy selected inputs to the outputs table:  

4. Select the desired Inputs. 

5. While holding the Alt key, drag the selection to the Outputs table. 

6. Drop the selection on the Outputs table. 

The selected inputs will be copied to the Outputs table. 

 

Note: You must use the I/O Adder to add Inputs and Outputs to the lists. 
   

Search Buttons 

 
Mapping Signals to the Search Buttons 

This function selects all of the inputs and outputs of the selected Signal Type. To map an existing signal 
type to one of the twelve buttons, click “Map Btns” to display the following dialog: 

 

Select one of the Signal Types in the left window and then click on the right-hand button that you wish to map the Signal Type to. The 
update will occur immediately. Click OK to close the dialog. 
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I/O Adder 

 

 

This is where you add inputs or outputs or both inputs and outputs simultaneously.  

How it works 
Determine whether you are going to add data to the Inputs list, the Outputs list, or both by selecting the appropriate button in the Add 
to Which List: frame: 

 

 

 
Type the name of the I/O in the “Name” field and enter the appropriate data in the “Connector,” “Signal Type,” and “Input Pin Style” 
and “Output Pin Style” fields.  

The Connector and Signal Type drop-downs are populated from the Connectors, and Signal Types Global Databases. 

 

 

Input Pin Styles 
Input pins can be displayed in one of two forms: Normal or Looped. See illustration below. 

Normal Input Pin 

 Looped Input Pin 

A looped input pin passes the signal on to another input and thus acts as both an input and an output. 

Output Pin Styles 
Output pins can be displayed in one of two forms: Normal or Bridged. See illustration below. 
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Normal Output Pin 

Bridged Output Pin 

A bridged output provides a parallel connection from a single output. 

 

 

 
If you are adding a single input, output, or both then select Add New. If you wish to add multiple I/O, then enter the number to multiply 
by in the Multiply By field and the appropriate start number in the Starting @ field. Then click on the Multiply By button (to the left of 
the Multiply By field) and WireCAD will create a new I/O for every multiple and append the number to the Name field. For example if 
you have a device that has 16 inputs all named “Line In”, rather than typing an entry for each of them, you would type “Line In-” in the 
name field. Then enter 16 in the Multiply By field and 1 in the Starting @ field. Selecting the Multiply By button will produce 16 entries 
in the input list starting at Line In-01 and ending at Line In-16. Selecting the persist info check box will leave the data in the fields after 
creating a new I/O.  

 

Display Preferences Tab 

 

The Display Preferences Tab allows you to determine a number of different ways to display the equipment block that you are about to 
create. You have the ability to display the block as any number of the following permutations: 
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Display Properties 
On the Display Preferences tab are a number of Display Properties that determine the outcome of the displayed device. 

 

 

Property Description Value Applies To: 

Body Color Sets the Body Color of 
the block. 

0-255 Normal equipment blocks. 
Not terminals. 

Body Width Sets the width of the 
block in drawing units. 

1-~ Normal equipment blocks. 
Not terminals. 

Pin Width Sets the width of the pin. 
In drawing units. 

Enum / Drop-down 
1,1.5,2 

Normal equipment blocks. 
Not terminals. 

Pin Spacing Sets the vertical pin 
spacing. In drawing units 

>1 Normal equipment blocks. 
Not terminals. 

Tear Left Side Tears the left side of the 
block. Works with the 
B l L ft V l

Boolean Normal equipment blocks. 
Not terminals. 
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Bulge Left Value 

Tear Right Side Tears the right side of the 
block. Works with the 
Bulge Right Value 

Boolean Normal equipment blocks. 
Not terminals. 

Tear Top Side Tears the top side of the 
block. Works with the 
Bulge Top Value 

Boolean Normal equipment blocks. 
Not terminals. 

Tear Bottom Side Tears the bottom side of 
the block. Works with the 
Bulge Bottom Value 

Boolean Normal equipment blocks. 
Not terminals. 

Bulge Left Side Polyline Bulge Distance. 
This value is set by the 
display style. Modify it to 
suit. 

Signed Double Normal equipment blocks. 
Not terminals. 

Bulge Right Side Polyline Bulge Distance. 
This value is set by the 
display style. Modify it to 
suit. 

Signed Double Normal equipment blocks. 
Not terminals. 

Bulge Top Side Polyline Bulge Distance. 
This value is set by the 
display style. Modify it to 
suit. 

Signed Double Normal equipment blocks. 
Not terminals. 

Bulge Bottom Side Polyline Bulge Distance. 
This value is set by the 
display style. Modify it to 
suit. 

Signed Double Normal equipment blocks. 
Not terminals. 

Visible Manufacturer Sets the visibility of the 
ManufacturerName 
Attribute 

Boolean Normal equipment blocks. 
Not terminals. 

Visible Equipment 
Name 

Sets the visibility of the 
EquipmentName 
Attribute 

Boolean Normal equipment blocks. 
Not terminals. 

Visible SysName Sets the visibility of the 
SysName Attribute 

Boolean Normal equipment blocks. 
Not terminals. 

Visible Alias Sets the visibility of the 
Alias Attribute 

Boolean Normal equipment blocks. 
Not terminals. 

Visible Location Sets the visibility of the 
Location Attribute 

Boolean Normal equipment blocks. 
Not terminals. 

Visible Connectors Sets the visibility of the 
Connectors text. 

Boolean Normal equipment blocks. 
Not terminals. 

Text Height Sets the Height of all 
visible text associated 
with a block 

Double Normal equipment blocks. 
Not terminals. 

Block Reference Path to an external 
drawing that physically 
represents the 
equipment.  

This value is set in 
the BlockRef field of 
the Equipment Data 
tab 

Used by the  

 

button. Ignores all other 
settings and inserts the 
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external reference into the 
drawing. 

Terminal Merge Mode Map merge modes are 
used to combine 
information from an input 
and an output into one 
terminal that displays 
both 

Enum / Drop-down 

None 

By Position 

Matching Text 

Used when mapping 
definitions to terminals. Not 
used by Normal equipment 
blocks. 

 

In addition, WireCAD v3 provides the ability to map an equipment definition onto a series of Terminals. This allows you the flexibility to 
display a jack-field, router, punch-block, or bulk-head panel as a series of terminals, as follows: 

 

Above demonstrates mapping an equipment definition of a jack-field onto a jack terminal.  

To map a selection to the terminal: 
1. Sort the input and output grids so that they line up appropriately. Remember that there are three map merge modes. Map 

merge modes are used to combine information from an input and an output into one terminal that has both; as in above. 

2.  Select the inputs and outputs to display. 

3.  Switch to the Display Preferences tab and select the terminal from the display grid. See Below. 

4.  Select the Merge Map Mode. 

5.  Check the preview display to insure a proper display. 

6.  Click the  to send the terminal(s) to the drawing. 

 
Create Equipment Block 
After you have found the piece of equipment that you wish to represent in your drawing, click on the 
Inputs/Outputs tab and select the appropriate I/O, either by clicking on the individual I/O or using the 
buttons. Then click Add This Item to Drawing. 

 
If you have not checked the Use Default Block Names check box in the preferences dialog, 
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then you will see a dialog asking you to confirm the name of the block to be created. You may either select 
the default, or enter a name of your own.  

 

 
 
Anatomy of an Equipment Block 
Equipment Blocks are comprised of the following attributes: 

 

 

The following table provides an explanation for each of the attributes: 

Attribute Description 

INPUT## Input. The inputs are labelled from the top of the block to the bottom 

OUTPUT## Output. The outputs are labelled from the top of the block to the bottom 

SysName The SysName. Concatenation of the SysNamePrefix and SysID 

Location Concatenation of the Location and Elevation fields of the SysName 
database 

Manufacturer Manufacturer 

EquipmentName Equipment Model 

EquipID Reference to the Equipment Library 

PinWidth A reference to the pin width 

Alias System Alias Field 
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Add Manufacturer to Library 

To add a manufacturer to the library click on the Add Manufacturer to Library button.  

 

Type the Manufacturer Name in the field. The ManufacturerID will be filled in automatically for you. Select the library where the name 
is to be displayed. Click Add. If the ManfacturerID already exists, you will be warn and given a chance to modify it.  

 

Add Equipment to Library 
To add a new piece of equipment to the library, click on the Add Equipment to Library button. 
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Select Manufacturer: Select an existing manufacturer from the drop-down list. 

Equipment Model: Enter the Equipment Model Number. 

Equipment Description: A short description  of the equipment. 

Equipment Type: This field is used to prefix system names. Note: use types that are easily recognizable to the engineering staff. This 
will aid in keeping your documentation readable. Example: if you are using an AVID non-linear editor (NLE) in your system it may be 
more readable to use AVID as the prefix instead of NLE; however, this assumes that the system will always by occupied by and AVID 
and may not be the best way to future proof your system. It’s a “salt to taste” issue. 

 

Drawing Cables, Terminals, Pointers etc. 
Important!! Draw cables in your drawing from output to input. WireCAD v3 now has a cable auto-router that will draw your cable for 
you and try to avoid other drawing entities and cables.  

Note: if you check the Avoid Other Cables box on the Draw Cables toolbar, WireCAD v3 will lay cables on top of other cables. 
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The Draw Cables Toolbar 
 

 

Repeat 

Restarts the Draw Cables function after successfully drawing a cable. 

 

Auto Place 

Automatically places Jacks, Terminals (Term) and Pointers in the drawing to the right or left of the selected input or output (based in 
the value in the AutoPlace Dist field). 

 

Auto Draw Pointers 

Checking this box with place linked pointer between the selected input and output. 

Note: this function will only work when the output and input are on the same sheet. 

 

Manual Draw 

Manually draw the cable.  

Note: When this function is selected, you will be prompted to draw a standard 2D polyline. Start by selecting the output and the left-
click for every vertex in the line (cable). Right-click to finish the command and draw the cable-text entities. 
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Drawing Cables Tutorial 
WireCAD version 3.2.1355 allows the drawing are cable from input to input and from output to output. Note, however, that the pin that 
is selected first will be assigned to the SrcPin and the pin that follows will be assigned to the DstPin field. Note further that this practice 
may cause erroneous connector counts. What follows is a detailed explanation of drawing cables. 

 

Start with a piece of equipment in the drawing: 

 

 

Next, select the Draw Cables button: 

 

Next, select an output on the equipment block: 
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We will now automatically draw a Jack to the right of the selected output. Select the Jack button: 

 

As follows: 

 

When selecting a Jack, Terminal, or Pointer you are given a choice of styles. Shown here are the Jack types:  
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Select the one called WC3_FN_JACK_SD: 

 

 Then click OK. This will insert a fully normalled jack pair: 

 

 

Note that the jack, cable, and cable number text are automatically placed in the drawing 4 drawing (number in the AutoPlace Dist field) 
units to the right of the output. 

If the objective is to draw from output to input on different blocks, then select the output first: 
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Next, select the input of the device. A cable and cable number text will be placed automatically. 

Note: WireCAD will try to avoid equipment and other cables (based on the Avoid Other Cables checkbox). If you need to move a 
piece of equipment, select it and then grab its grip and drag it to its new location. The wires will remain attached to it and relocate 
based on the location. 
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If the objective is to draw from our existing jack to the block, then start the Draw Cable function 

 and click on the jack. 

  

 

 

 

 

Drawing Pointers Automatically 

Check the Auto Draw Pointers checkbox. Start the Draw Cables function. 

 

Next, Select the Output followed by the Input.  
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Manually Drawing Cables 

Check the Manual Draw checkbox. Start the Draw Cables function. 

 

You will be prompted to start drawing a polyline. Select the Output. Draw the polyline in any direction needed. 

 

 Finish by selecting the desired Input. End the command by right-clicking. This will place the cable# text entities. 
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Drawing Jacks, J-Boxes, etc as Sources to the Cable 

If you need to have a Jack, Terminal, or Pointer feed an input. Select the terminal button first.  Note that the Manual 
Draw function must be unchecked in order to enable the terminal switches. Selecting any of the terminal buttons will start the Draw 
Cable function. 

 You are then prompted to select a destination. Upon doing so, if the Auto Place function is checked, the 
selected Terminal will be placed to the left of the Input based on the number defined in the Auto Place Dist field: 
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Turning off Auto Place will prompt you for locations to place the terminal devices and then draw cables to the selected location. 

 

On-Sheet and Off-Sheet Pointers 
WireCAD supports the use of on-sheet and off-sheet pointers. These are placed in the drawing using the Draw Cables function. 
Alternately, pointers can be placed using the Insert block function and then drawn to or from them. When using the Auto Draw 
Pointers function, WireCAD automatically links the pointers together. When using the Pointer Terminal button to place pointers in the 
drawing, these pointers will require linking.  

 

Linking Pointers 
Pointers can be linked on sheet or off. Simply double-click the pointer on the output side of the cable: 
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You will be prompted to select a pointer in the current drawing or in another drawing: 

 

 

In any case, click on the other pointer to link them together. 

 

 

Note that the two pointers are filled in with the reciprocal information. In other words, the pointer on the output side is filled 
in with the information from the input side and vice versa: 
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Assigning System Names to Equipment  
Assignment is the term used to indicate that a drawing entity has an associated entry in the database. We refer to several types of 
assignment: 

• SysNames, or system specific identifiers. Thus allowing multiple instances of the same equipment type. This process is 
where you define the physical location of the equipment in the system. 

• Terminals, terminals must first be assigned to the project database. This process is where you define the physical location 
of the equipment in the system. 

• Cable Numbers. 

Assigning System Names (SysNames), Jacks, Jack Fields, and Cable Numbers is as easy as double-clicking on the entity you wish to 
assign. Depending on the entity type you will be presented with a series of different dialogs to handle the interface between the 
drawing environment and the database. If you double-click an equipment block, the following dialog will appear: 

 

Note: A SysName can be assigned to multiple instances of an equipment insert. As an example, assume two drawings – one 
containing only video, the other containing only audio. Both with a VTR called VTR-01.  

Prefix: Sets the prefix for the system Name. Direct entry into this field is possible. This field is referenced to the EquipmentType 
field in the Equipment Library. The Prefix and the SysNum will be concatenated to form the SysName. 

 

Record Selectors:  Used to select an existing SysName. Upon selecting 
an existing SysName, click OK. You will be informed that the System Name already exists, and prompted whether to proceed with 
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naming the insert. Selecting the New Record button  will append a record to the database and increment the SysNum 
counter. 

Note that WireCAD v3 automatically assumes a new record as indicated above by the * in the SRVR-01* SysName preview. 

Location: User defined location field.  

Elevation: User defined elevation field. 

System Alias: Use this field to provide functional or friendly names to systems. Example: suppose you have VTR-450 in your 
system but the function of this device is Fred’s Viewing Deck. Enter “Fred’s Viewing Deck” in the alias field to provide an additional 
description to VTR-450. 
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Assigning System Names to Individual Terminals 
If you have paced WireCAD Terminals in your drawing, these will need to associated with a specific input/output of a specific 
SysName. For example: suppose we have a jack point in a drawing. That jack point will need to physically occupy a position in a jack-
field. The jack-field will have a SysName such as JF-01 and the jack may be the first jack in the top row, say, A-1. The first step in the 

process is to assign the jack-field to the project. This is done in the Equipment Library . Find the equipment definition and click the 

Add This System to Project button .  

This will launch the now familiar Assign Systems dialog mentioned above. 

 

Once you have defined a SysName for your terminal device, you can now assign the individual terminal to the SysName. 

 

To accomplish this, double-click on the terminal in the drawing.: 

 

This launches the following dialog where you determine the input/ouput or both that this terminal is to represent: 
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Select a system from the drop-down. This displays the collection of inputs and outputs for the selected system. Records that are 
displayed in red are already assigned cable numbers. 

 

Clicking OK will update the information in the drawing: 
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Assigning Cable Numbers 
Once the systems attached to a cable have been given SysNames, Cables can be assigned Cable Numbers.  

To assign a single cable, double-click on a cable to assign it to the database.  

To assign multiple cables at once, use the menu Cables>Assign to Database. Then select the cables to assign.  Right click to 
continue. 

 

The Assign cable numbers function does several things: 

• Retrieves cable source and destination information from the drawing. 
• Retrieves the Cable Number Prefix to be used from the Signal Types database based on the source signal type. 
• Checks the database for existing entries. If found presents a dialog prompting how to proceed. 
• If the Verify Settings check box in the Project Preferences>Cables is checked, displays the Verify Settings dialog allowing 

editing of the information to be sent to the database. This is also where you determine if you want to assign the cable as a 
multi-core cable. 

• Updates the database. 
• Updates the drawing. 
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Verify Cable Settings 
The Verify Settings dialog allows you to edit information before it is sent to the database. This dialog is displayed only if the Project 

Preferences>Cables>Confirm Cable Settings checkbox is checked.  

 

Prefix: Cable number prefix determined by the Signal Type field. 

Available: The next cable number or choose an existing one. This field is determined by the Prefix field, and will retrieve the next 
number in sequence for the given prefix along with all available cable numbers associated with the Prefix. If Prefix is null, Available 
provides the next un-prefixed and all available un-prefixed numbers. This field is directly editable in the event that you need to enter 
cable numbers out of order. 

Source/Destination Location: The source and destination locations. 

Source/Destination Connector: The source and destination Connectors. 

Source/Destination Alias: The source and destination Aliases. 

Cable Length: User definable field. 

Integrator: User definable field. 

Core Type: Single and Multi-core cable types. 

Cable Type Manufacturer: The cable type manufacturer. 

Cable Type Part Number: The cable type part number. Note that this field displays single core cables when the Core Type Single, 
and Multi-core cables models when Core Type is New Multi-core. 

 

Multi-core Cable Numbers 
This function is available only when Project Preferences>Cables>Confirm Cable Settings checkbox is checked. 
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WireCAD supports multi-core cable numbers. WireCAD does this by building a multi-core cable structure based on the cable number 
prefix, the current number, and the pair data from the selected multi-core cable part number. WireCAD creates an entry in the Project 
Cables Database for every core in the selected Cable Type following this convention: 

CableNoPrefix – Current Number – Pair Data 

Example: 

Assume a Cable Number Prefix of V the current number is 1001 and a multi-core CableType with three cores. Further, that the Pair 
Data for the three cores is a simple numeric progression. The resultant Project Cable Database entries would be created: 

V-1001-1 

V-1001-2 

V-1001-3 

Note that the CableNoPrefix is actually a separate field and is only concatenated here and in the drawing. 

Further, assume that the Pair Data is not a numeric progression but a color code containing the entries Red, Grn, Blu. The resultant 
Project Cable Database entries would be created: 

V-1001-Red 

V-1001-Grn 

V-1001-Blu 

The data from the current assignment is given to the first entry and the remaining entries are marked available and show up in the 
Available drop down discussed above. 

 

To build a multi-core cable structure, select New Multi-core from the Core Type frame: 
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Next, select the Manufacturer and Cable Part Number from which to build the structure. Here we have selected the Gepco 6608 HS 
that we have defined in our Cable Types library to have the following pair data: 

 

Next click the Build Multi-core Structure and Continue button. The information from the Source and Destination fields is given to the 
first entry in the structure and the remaining entries are created and marked available. 
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Existing Assignment Dialog 
In the event that you are assigning a cable that already exists in the drawing (this can occur for a number of reasons including drawing 
revisions, etc.). WireCAD will present the following dialog prompting you to take action: 

 

 

Here you are given a number of options including keeping the same number with the assignment or giving a new number to the 
assignment. WireCAD then checks the drawing for existing instances of the cable number in question and if found prompts you to 
keep to delete each instance. 

If the Verify Settings checkbox is checked you will then be presented with the Verify Settings dialog. Otherwise, the assignment will 
proceed. 
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Global Databases 
WireCAD maintains a set of databases that are common to all projects. These databases manage: 

• Projects information. 
• Manufacturers. 
• Equipment. 
• Connectors. 
• Signal Types. 
• Cable Types. 
• Jack Fields. 
• Industry Sectors. 

 

Enterprise Client Edition Note 
The Enterprise Client Edition also exposes a table that displays the 
permissions of the user. 
 

A Note About WireCAD Datasheets 
Some WireCAD datasheets are directly editable while others are presented as read only. 

 If a table will allow the addition of records it will contain this Add Record field at the top of the sheet: 

 

 

Some datasheets allow grouping by column. Simply drag the column’s header into this box: 

 

The grid will be reconfigured to apply the grouping. 

The following grid displays the project cable data without grouping: 
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The following grid displays the project cable data grouped by the CableNoPrefix field: 

 

Exporting and Printing Grids 
WireCAD datasheets can be exported to MS Excel format files using the function Projects>Import/Export>Export to Excel.  

Most WireCAD datasheets can be printed using the Projects>Print Grid function. The exception is the Reports Datasheet that displays 
the data associated with a report that is loaded into the Report generator. 

 

Sorting Data 
Clicking the column header with cause the datasheet to sort according to the selected column in ascending order clicking again with 
sort descending. 
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The following example displays the column headers for the fields “CableNoPrefix” and “CableNo”. The grid is sorted in ascending 
order on the “CableNo” field. 

 

 

A grid may only be sorted on one field unless the grid allows grouping. In which case the grouped field will be sorted as well as an 
additional field of your choice. 

 

Projects 
This database maintains pointers to the existing Project Databases. 

A datasheet view of this database is available from the Project Explorer>Global Databases node and from the menu 
Database>Projects. This database also maintains the “CurrentRevision”. This field can be used to manage cables and data by 
revision. Anytime a cable number is assigned the value in the “CurrentRevision” field will be placed in the cables database.  

Please note that changes to the “CurrentRevision” field will not be reflected in the project until you re-launch WireCAD 

 

Manufacturers 
This database maintains Manufacturer names and the Libraries that they are to be displayed in.  

A datasheet view of this database is available from the Project Explorer>Global Databases node and from the menu 
Databases>Manufacturers. 
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Equipment Library 
The equipment library is comprised of several databases and references the Manufacturers database. Tables included are: 

• Equipment 
• Manufacturers. 
 

A datasheet view of this database is available from the Project Explorer>Global Databases node and from the menu 
Databases>Equipment. The grid display of this database is useful for editing equipment data such as the vendor and cost information. 

 

Note that the global datasheet view will not display Inputs and Outputs. 

 

Signal Types 
The Signal Type database determines the behaviour of many WireCAD functions. It maintains information that relates which cable 
type and cable number prefix to which Signal Type as well as determining how to display a Signal Type in your drawing: 
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Type: The abbreviated Signal Type used in many Signal Type selection boxes throughout WireCAD. 

Color: The Color Number. Range 0-255 and Same as Layer. Same as layer will permit the Signal Layer to determine the color of the 
entity. 

SignalType: Description. 

CableManu: Cable Type Manufacturer. 

CableType: Cable Type model number. 

CableNoPrefix: Cable Number Prefix. Used in the assignment of cable numbers. If this field is blank the prefix will be blank. 
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Cable Types 
Add and edit Cable Types and associated Pair Data. Pair data is used when creating Multi-core cable numbers. 

 

Add Manufacturer: Opens the Add Manufacturers dialog. 

Edit Manufacturer: Future. 

Add Cable Type: Opens the Add Cable Types dialog. 

Delete Cable Type: Deletes the highlighted cable type. This cannot be undone. 

Edit Pair Data: Same as clicking the Cable Pair Data tab. 

Cable Data: Information about the highlighted Cable Type. 

Adding Cable Types 
Add a new Cable Type with its associated data. This data is for reference only as it not use elsewhere. The exception is the cable pair 
data which is used to determine the number of cores to add for a Multi-core cable and determines how they are labelled. 
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Connectors 
The Connectors database maintains information on connectors 

 

Connector: The abbreviated connector used in many connector selection boxes throughout WireCAD. 

Description: Description. 

ConnVendor1: One of two user definable connector vendor fields. 

ConnVendor2: The other. 

ConnCost1: One of two user definable connector cost fields. 

ConnCost2: The other. 
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Project Databases 
WireCAD maintains a separate project database for each project. This database is located in a folder inside the project folder named 
“Project Databases”. Project databases contain project specific information like: 

• Project Drawings. 
• Systems. 
• Cables. 
• Jack Fields (for v2 compatibility). 
 

Note: WireCAD Personal contains only one project named Default Project contained in the WireCAD directory\WireCAD Default 
Project\Project Databases\. 

 

Systems 
Contains System Name and manufacturer and model information for each System Name in the project.  

 

Cables 
Contains Cable information. Note that WireCAD does not actually delete an existing cable but marks it as available. If cables are 
deleted from the database (which is possible) you may notice inconsistencies in the new cable number. 
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Jack Fields 
Retained for legacy purposes. WireCAD v3 does not use this table unless you are working with version 2 jacks and jackfields. 

Contains Jack Field and Jack information. 
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Drawings 
Displays a list of all drawings that are associated with the current project. Any drawing opened in WireCAD is automatically associated 
with the project. A number of additional fields can be populated for each drawing. These fields include: Descriptions, Revision number, 
etc. 
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The Reporting Environment 
WireCAD allows database reporting using the Reports form. This form contains several sections that are exposed by clicking the tabs 
at the bottom of the screen: 

• Preview Tab: selecting this tab displays the current report in print preview mode. 
• Design Tab: displays the report designer. 
• Data Sheet Tab: displays the data associated with the report. This datasheet may or may not be editable depending on the 

complexity of the retrieved data. 
• Conditions Tab: allows the application of complex conditions to the data. 

 

 

Opening and Previewing Reports 
With the Reports form active; reports can be opened from the Standard Toolbar, File Menu, and directly from the Project Explorer. The 
initial view for an opened report is Print Preview. Use the standard view selection buttons to determine display current page, page lay-
up, and zoom factor. 

Page Setup 
Displays a standard Window Page Setup dialog. 

Print Reports    
Print the report to the active Windows printer. 
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The New Report Wizard 
Clicking New Report in the Project Explorer will present the New Report Wizard. This will lead you through the steps of creating a new 
report. You are given opportunity to select the data from which to create the report, define relationships, sorting, and appearance.  

 

 

Label Reports 
The Report Wizard does not currently support the creation of Labels. The best way to create a new label definition is to modify an 
existing one. Do this by opening an existing definition and save it as a new name. Next, modify it to accommodate your needs. 

The Report Designer 
The Report Designer provides a means by which to create and edit report definition files (*.rpx). The WireCAD Report Wizard creates 
the necessary controls to retrieve the data from the database. This is the ADO control that you see on the report and is named DC1.  

Report Sections 
The Report Designer permits the grouping of controls by section. Sections can include Header, Detail, Footer. WireCAD also provides 
additional grouped data sections. These can be added automatically using the New Report Wizard, or by right clicking in the designer 
and choosing Insert>Group or Insert>Report Header/Footer. The designer must have at least one section named Detail. 

 

Section Appears Typically Contains 

Report header Once per report The report title and summary information for 
the whole report. 

Page header Once per page Labels that describe detail fields, and/or 
page numbers. 

Group header Once per group Fields that identify the current group, and 
possibly aggregate values for the group 
(e.g. total, percentage of the grand total). 

Detail Once per record Fields containing data from the Source 
recordset. 

Group footer Once per group Aggregate values for the group. 

Page footer Once per page Page number, page count, date printed, 
report name. 

Report footer Once per report Summary information for the whole report. 
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Tools 

 

 

The Report Designer provides a set of tools for placing Labels, Fields, Shapes, Images, etc. on the layout. Click the tool in the toolbar 
or menu that you wish to use and Place the item in the appropriate report section. Available tools are: 

• Label:  used to place unbound text. 

• Field:  bound/calculated text. Bound Fields can be place  from the Field List toolbar. Simply drag the field onto the 
section and drop. The field will then be bound.  

• Checkbox:  bound Boolean field. 

• Image:  bound/unbound image. 

• Line:  unbound line. 

• Shape:  unbound shape. 

• Frame:  unbound frame. 

• Sub-report:  sub-report use the properties window to bind to appropriate data. 

• Page Break:  insert a page break. 

• OLE container:  place an OLE bound or linked object such as a word document etc. 

• Barcode:  bound barcode field. 
 

Modify 
Use tools on the Modify toolbar to change the appearance of the selected item(s).  

Align 
Use tools on the Align toolbar to change the Alignment of the selected item(s). 

Calculated Fields 
An unbound field can be used to calculate values and concatenate strings. Follow these conventions to calculate fields. 

Example: 

If we want to create a composite Cable Number using the fields CableNoPrefix and CableNo. We would enter the following data in the 
DataField property of the selected field. This is found in the Report Properties window. 

 

This will place a space between the two fields that we are concatenating together. The result would look something like: V 1001. 

Mathematical operations can be performed as well if the fields in question are numeric. Simply follow the = sign by whatever operators 
you wish to apply to which fields. The Sum and Count functions are not directly available to calculate fields but are available by 
assigning the correct values to the SummaryField property. See section below. 
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Note: field names are not case sensitive.  

 

Summary Fields 
Summary fields are fields that provide summary information. A field must first be assigned a DataField to bind to. Next, set the 
following properties to create the desired behaviour. 

• SummaryDistinctField: property sets or returns the name of the field used in a distinct summary function.  The summary 
function will process DataField values based on the distinct value of this field. 
Note:  This property is used only when the SummaryFunc value is one of Distinct Summary Functions.  When using the 
summary functions with a field, the CanGrow and CanShrink properties are disabled for the field. 

• SummaryFunc: Sets the type of the summary function used to process the DataField values.  You can use this function to 
create sub totals, grand totals and other summary values. 

Summary Functions: 
Mnemonic Description 

ddSFSum Calculates the total of all values within the specified summary region (group, 
page report). 

ddSFAvg Calculates the average of all values within the specified summary region 
(group, page or report). 

ddSFCount
  

Calculates the count of all values within the specified summary region (group, 
page or report). 

ddSFMin  Calculates the minimum of all values within the specified summary region 
(group, page or report). 

ddSFMax  Calculates the maximum of all values within the specified summary region 
(group, page or report). 

ddSFVar  Calculates the variance of all values within the specified summary region 
(group, page or report). 

ddSFVarP
  

Calculates the population variance of all values within the specified summary 
region (group, page or report). 

ddSFStdDev
  

Calculates the standard deviation of all values within the specified summary 
region (group, page or report). 

ddSFStdDevP
  

Calculates the population standard deviation of all values within the specified 
summary region (group, page or report). 

ddSFDSum Calculates the total based on the distinct values of another field within the 
specified summary region (group, page or report). 

ddSFDAvg
  

Calculates the average based on the distinct values of another field within the 
specified summary region (group, page or report). 

ddSFDCount
  

Calculates the distinct count based on the distinct values of another field within 
the specified summary region (group, page or report). 

ddSFDVar
  

Calculates the variance based on the distinct values of another field within the 
specified summary region (group, page or report). 

ddSFDVarP
  

Calculates the population distinct variance based on the distinct values of 
another field within the specified summary region (group, page or report). 

ddSFDStdDev
  

Calculates the standard deviation based on the distinct values of another field 
within the specified summary region (group, page or report). 

dSFDStdDevP
  

Calculates the population standard deviation based on the distinct values of 
another field within the specified summary region (group, page or report). 

• SummaryGroup: property sets or returns the name of the group header section that will reset the summarized field value.  
For example, setting a sum of price for an order group header, will reset the sum to zero for each order group.  This property 
is valid when the SummaryType is set to 3-SubTotal. 

Note:  When using the summary functions with a field, the CanGrow and CanShrink properties are disabled for the field. 
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• SummaryRunning: determines whether the summarization will be accumulated or reset for each level (detail, group or 
page).  Setting this property ddSRGroup or ddSRAll will make WireCAD print a running summary of the field at the group or 
report level. 
Note:  When using the summary functions with a field, the CanGrow and CanShrink properties are disabled for the field. 

• SummaryType determines the type of summarization on the field if any.  WireCAD can summarize the field as: 
• Sub total (group level; reset for each group). 
• Grand total (report level; do not reset until all records are processed). 
• Page total (page level; reset for each page). 
• Or a page count, which is the total number of pages printed. 

Summary Types: 
Mnemonic Description 

ddSMNone  No summarization. 

ddSMGrandTotal  Specifies a report level summary, evaluates the summary function for all 
records in the report. 

ddSMPageTotal  Specifies a page level summary, evaluates the summary function for all 
records on each page. 

ddSMSubTotal  Specifies a group level summary, evaluates the summary function for all 
records in each group level. 

ddSMPageCount  Specifies a Page Count field. 

 

The ADO Control Explained 

Every WireCAD report contains one and only one ADO control . This control is responsible for retrieving data from the 
database. WireCAD can only assign this control to one of its databases at a time. If this control is deleted from the report layout it will 
not provide data, nor will it be able to fill in the Fields List Toolbar.  

ADO Properties  
This is an expanded view of the ADO control Properties window. Listed below are some of the key functions others are self-
explanatory, explained in the description field when the property is highlighted, or non-essential to report creation. 
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Custom: Presents another version of the property window. 

Name: Do not change this from DC1. 

ConnectionString: This is the type, and location of the WireCAD database that we are retrieving data from. Do not edit this. 

Source: A SQL select statement used to determine which fields from which tables related to which other tables and in which order to 
display. Whew! That’s a mouthful. While it is beyond the scope of this manual to provide a lesson in SQL suffice it to say that the 
statement “Select * from [tblCables] ORDER BY [CableNo]“ will retrieve all records from the cables table and sort them by cable 
number. For more information view some of the existing reports. 

Tag: Used within WireCAD to identify the data source. DO NOT EDIT THIS! 

 

The Properties Window  
Dock-able window used to edit properties associated with the Report Designer. For more information on a property – highlight the 
property in question and read the description from the description field below. 

 

Some Notes About Cable Labels 

The fastest way to customize a new cable label is to open an existing one and use the SaveAs function to create a new 
report file with a different name. See the section on Calculated Fields for information on creating concatenated fields. 
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Applying Report Conditions Tutorial 
WireCAD provides powerful report Condition generator that allows you to apply complex conditions to you data. Selecting the 
Condition tab at the bottom of the Reports form displays this form: 

 

 

Next click on the button with the ellipsis (…) and select Add a new elementary condition. 
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Next, click on the first asterisk to display a list of the fields associated with the report. Select ManufacturerName. 

 

Here we can determine a number of equality operators including <, >, =, Not =, Contains, Starts With, etc. We will leave the default Is 
Equal To. This will create a condition statement where ManufacturerName is equal to ??? 
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Next, click on the second asterisk to display an edit box and enter ADC in the field: 

 

 

Next, click the Apply button to apply the conditions and switch to Print Preview Mode. 
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Thus creating a report limited to the Jack Field Manufacturer ADC.  

The Conditions generator is very powerful and can apply multiple conditions. This is useful if you need to print a range of cable 
numbers or even a range of cable numbers that apply to a given source or destination. You can use it to print equipment pertaining to 
a certain location.  

To clear existing conditions, click the Conditions tab and then click the Clear Conditions button. 
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How To 
This section provides details on how to perform several basic WireCAD functions. Some of these descriptions appear elsewhere in the 
text. 

How to Create a New Project 
Creating a new project in WireCAD creates a new folder with the project name in the directory of your choice and places two 
additional folders in that folder. As follows: 

 

This process simultaneously creates an entry in the projects database. 

Start the function by clicking the Project\New Project menu.  The New Project Dialog will appear: 

 

� Enter a Name for the new project. This name should follow file naming conventions. Do not use more than one period and 
no ‘ characters.  

� Enter a description for the Project. Description are anything your want to use to identify the project. 

� Click the  button and browse to the location on the local drive or network share where you want to store the 
Project folder.  

� Click the Add New button.  

Done. 
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How to Create a New Drawing 

Double-click this icon on the Project Explorer or  on the Standard toolbar. You will be prompted to 
select a WireCAD template drawing.  

Template Drawings 
When you create a new drawing in WireCAD you are prompted to select from a number of template drawings. These drawings are 
prepared to receive input from WireCAD. The template drawings also provide a default layout for the ANSI drawing size indicated. To 
create your own templates, modify an existing template and save the drawing in the WireCAD3\TemplateDrawings folder. 

 

NOTE: You can customize a template drawing with all of your default company and project 
information. Then save the drawing into the \WireCAD3\TemplateDrawings folder and it will be 
available from this view. Now you will not have to enter redundant information and can insure 
symmetry between drawings. 

 

 

� Click OK 

� You will be prompted to name the drawing. Name your drawings something other than drawing##. If WireCAD sees a 
drawing name that starts with the string “drawing”, you will be prompted every time to save as. 

Done. 
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How to Add Equipment to the Drawing 
Start this  function by clicking Tools>Equipment>Equipment Library, or the  button. This will display the Equipment Library: 

 

� Select the Search Field upon which to search. 

� Type the search text into the Search Text field and Click the Find button. 

� Matching records will be displayed in the grid. 

� Select the desired Equipment definition. All of the inputs and outputs are automatically selected for inclusion in the block. 

� Switch to the Inputs and Outputs tab. 

� Modify your selection to suit. Use the Clear Selections button.  

� Click on the record selector  to add an Input or Output. If the preview display is not immediately updated, click on the 

Update Preview button.  

� Once you have selected the desired inputs and outputs, click on the Display Preferences tab. 

� Select the desired display style. 

� Click on the Add This Item to Drawing Button.  

� The Equipment Library will close and you will be prompted to place the new equipment in the drawing. 

Done. 
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How to Draw Cables 
WireCAD drawing conventions dictate that cables are to be drawn from output to input. What follows is a detailed explanation of 
drawing cables. 

 

� Start with a piece of equipment in the drawing: 

 

 

� Select the Draw Cables button:  

� Select an output on the equipment block: 
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We will now automatically draw a Jack to the right of the selected output.  

� Select the Jack button:  as follows: 

 

When selecting a Jack, Terminal, or Pointer you are given a choice of styles. Shown here are the Jack types:  
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Select the one called WC3_FN_JACK_SD: 

 

� Then click OK. This will insert a fully normalled jack pair: 

 

 

Note that the jack, cable, and cable number text are automatically placed in the drawing 4 drawing (number in the AutoPlace Dist field) 
units to the right of the output. 

If the objective is to draw from output to input on different blocks, then select the output first: 
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Next, select the input of the device. A cable and cable number text will be placed automatically. 

Note: WireCAD will try to avoid equipment and other cables (based on the Avoid Other Cables checkbox). If you need to move a 
piece of equipment, select it and then grab its grip and drag it to its new location. The wires will remain attached to it and relocate 
based on the location. 

 

 

If the objective is to draw from our existing jack to the block, then start the Draw Cable function 

  and click on the jack. 
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Drawing Pointers Automatically 

Check the Auto Draw Pointers checkbox. Start the Draw Cables function. 

 

Next, Select the Output followed by the Input.  
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Manually Drawing Cables 

Check the Manual Draw checkbox. Start the Draw Cables function. 

 

You will be prompted to start drawing a polyline. Select the Output. Draw the polyline in any direction needed. 

 

Finish by selecting the desired Input. End the command by right-clicking. This will place the cable# text entities. 

 

Drawing Jacks, J-Boxes, etc as Sources to the Cable 

If you need to have a Jack, Terminal, or Pointer feed an input. Select the terminal button first.  Note that the Manual 
Draw function must be unchecked in order to enable the terminal switches. Selecting any of the terminal buttons will start the Draw 
Cable function. 
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 You are then prompted to select a destination. Upon doing so, if the Auto Place function is checked, the 
selected Terminal will be placed to the left of the Input based on the number defined in the Auto Place Dist field: 

 

Turning off Auto Place will prompt you for locations to place the terminal devices and then draw cables to the selected location. 
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How to Add Equipment to the Library 
Start this function by clicking Tools>Equipment>Equipment Library, or the  button. This will display the Equipment Library: 

 

To add a new piece of equipment to the library, click on the Add Equipment to Library 

 button.  

 
� Select a manufacturer form the drop-down. 

� Enter the Model 

� Enter the Description 

� Enter the Equipment Type. This field is used to prefix system names. Note: use types that are easily recognizable to the 
engineering staff. This will aid in keeping your documentation readable. Example: if you are using an AVID non-linear editor 
(NLE) in your system it may be more readable to use AVID as the prefix instead of NLE; however, this assumes that the 
system will always by occupied by and AVID and may not be the best way to future proof your system. It’s a “salt to taste” 
issue. 

� Click Next 
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� Enter data in the Categories field. Use keywords that describe the categories of equipment that this equipment belongs to. 
You can use multiple words separated by a comma.  

� Enter data in the Synonyms field. Use keywords that describe the device; such as: CPU, COMPUTER, SERVER. 

� Click Next  

 
� Use the > button to move industry sectors from the left-hand list to the right-hand list. Note: this list is populated from the 

Industry Sector global database. 

Done. 
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How to Add Manufacturers to the Library 
Start this function by clicking Tools>Equipment>Equipment Library, or the  button. This will display the Equipment Library: 

� Click the Add Manufacturer to Library button  

� WireCAD will display the Add Manufacturer Dialog: 

 

 

Type the Manufacturer Name in the field. The ManufacturerID will be filled in automatically for you. Select the library where the name 
is to be displayed. Click Add. If the ManfacturerID already exists, you will be warn and given a chance to modify it.  
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How to Assign a System Name 
Assignment is the term used to indicate that a drawing entity has an associated entry in the database. We refer to several types of 
assignment: 

• SysNames, or system specific identifiers. Thus allowing multiple instances of the same equipment type. This process is 
where you define the physical location of the equipment in the system. 

• Terminals, terminals must first be assigned to the project database. This process is where you define the physical location 
of the equipment in the system. 

Assigning System Names (SysNames), Jacks, Jack Fields, and Cable Numbers is as easy as double-clicking on the entity you wish to 
assign. Depending on the entity type you will be presented with a series of different dialogs to handle the interface between the 
drawing environment and the database. If you double-click an equipment block, the following dialog will appear: 

 

Note: A SysName can be assigned to multiple instances of an equipment insert. As an example, assume two drawings – one 
containing only video, the other containing only audio. Both with a VTR called VTR-01.  

Prefix: Sets the prefix for the system Name. Direct entry into this field is possible. This field is referenced to the EquipmentType 
field in the Equipment Library. The Prefix and the SysNum will be concatenated to form the SysName. 

 

Record Selectors:  Used to select an existing SysName. Upon selecting 
an existing SysName, click OK. You will be informed that the System Name already exists, and prompted whether to proceed with 
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naming the insert. Selecting the New Record button  will append a record to the database and increment the SysNum 
counter. 

Note that WireCAD v3 automatically assumes a new record as indicated above by the * in the SRVR-01* SysName preview. 

Location: User defined location field.  

Elevation: User defined elevation field. 

System Alias: Use this field to provide functional or friendly names to systems. Example: suppose you have VTR-450 in your 
system but the function of this device is Fred’s Viewing Deck. Enter “Fred’s Viewing Deck” in the alias field to provide an additional 
description to VTR-450. 

 

Assigning System Names to Individual Terminals 
If you have paced WireCAD Terminals in your drawing, these will need to associated with a specific input/output of a specific 
SysName. For example: suppose we have a jack point in a drawing. That jack point will need to physically occupy a position in a jack-
field. The jack-field will have a SysName such as JF-01 and the jack may be the first jack in the top row, say, A-1. The first step in the 

process is to assign the jack-field to the project. This is done in the Equipment Library . Find the equipment definition and click the 

Add This System to Project button .  

This will launch the now familiar Assign Systems dialog mentioned above. 

 

Once you have defined a SysName for your terminal device, you can now assign the individual terminal to the SysName. 

 

To accomplish this, double-click on the terminal in the drawing.: 
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This launches the following dialog where you determine the input/ouput or both that this terminal is to represent: 

 

Select a system from the drop-down. This displays the collection of inputs and outputs for the selected system. Records that are 
displayed in red are already assigned cable numbers. 

 

Clicking OK will update the information in the drawing: 
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How to Assign a Cable Number 
 See the topic: Assigning Cable Numbers 
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Appendix 
Table Structures 

dbEquip.mdb Table Definitions – Equipment Database 
Table Name Description Related To: 

SignalDefault Future NA 

SignalUser Future NA 

tblCablePairs Listing of cores and core 
IDs for Multi-core Cable 
Types 

tblCableTypes 

tblCableTypes Cable Types Data tblCablePairs 

tblConnectors Connector Data NA 

tblEquipment Equipment Data excluding 
input and output info 

tblManufactureres, 
tblInputs, tblOutputs 

tblInputs Equipment Input Data tblEquipment 

tblOutputs Equipment Output Data tblEquipment 

tblJackFields Jack Field Data tblManufacturers 

tblManufacturers Manufacturer Data tblEquipment, 
tblJackFields, tblRTR, 
tblCableTypes 

tblPreferences Preference Data TblUsers 
 

tblRackUnits Future NA 

tblRTR Router Data (future) tblRTRInputs, 
tblRTROutputs 

tblRTRInputs Routers Input Data(future) tblRTR 

tblRTROutputs Router Output 
Data(future) 

tblRTR 

tblUsers User Data TblPreferences 

   
 

dbPM.mdb Table Definitions – Project Manager Database 
Table Name Description Related To: 

tblClientInfo Maintains Data About 
Y Cli

tblProjects 
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Your Clients 

tblCompany Your Company Info  

tblProjects Project Data tblDrawings, tblDwgTypes, 
tblDefaultDwgTypes 
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ProjectDB.mdb Table Definitions – Project Specific Database 
Table Name Description Related To: 

tblJFRowCol Project Jack Field 
Individual Jacks Data 

tlbJF 

tblCables Main Cable Database tblChildCables 

tblChildCables Child Cable Database (Not 
Used – Legacy) 

tblCables 

tblJF Project Jack Fields JFRowCol 

tblPID Pointer ID Generator  

tblRTR Project Routers (future) tblXP 

tblSystems Project Sysnames  

tblXP Project Router Cross-
Points 

tblRTR 

tblBOMMaster Contains the BOM 
FileName 

tblBOM 

tblBOM BOM table TblBOMMaster 

TblDrawings Project Drawings NA 
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WireCAD Necessary Layers 
The following layers are necessary to proper operation of WireCAD: 

Layer Description 

Alias Equipment Block Alias attribute 

Cables Base Cable layer. Most cables will change off of this layer based on Signal 
Type. 

Comments Future 

Connectors Equipment Block connectors 

Equipment Equipment Block EquipmentName attribute 

Location Equipment Block Location attribute 

Manufacturer Equipment Block Manufacturer attribute 

Pinnames Equipment Block I/O attributes 

Sysnames Equipment Block System Name attribute 

 

WireCAD Necessary Text Styles 
The following text styles are necessary to proper operation of WireCAD: 

Text Style Description 

Simplex Jacks, J-Boxes, Router Cross-points, Pointers 

WC_EQUIPMENT Equipment Block EquipmentName attribute 

WC_MANUFACTURER Equipment Block Manufacturer attribute 

WC_PIN Equipment Block I/O attributes 

WC_CABLENO CableNo text entities 

WC_SYSNAME Equipment Block SysName attribute 

WC_ALIAS Equipment Block Alias attribute 

WC_LOCATION Equipment Block System Location attribute 

WC_CONNECTOR Equipment Block System Connector attribute 
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WireCAD Necessary Blocks 
The following Blocks are necessary to proper operation of WireCAD: 

FN_JACK_SD Full normal jack set 

FN_JACK_S Full normal source jack 

FN_JACK_D Full normal destination jack 

HN_JACK_SD Half normal jack set 

HN_JACK_D Half normal source jack 

HN_JACK_S Half normal destination jack 

JACK1_1_SD Non normal jack set 

JACK1_1_S Non normal source jack 

JACK1_1_D Non normal destination jack 

JBOX_S J-Box source side 

JBOX_D J-Box destination side 

JBOX_1_S J-Box source side 

JBOX_1_D J-Box destination side 

LOOPIN Looping input 

POINTER_S Pointer source side 

POINTER_D Pointer destination side 

RTR_S Router source side 

RTR_D Router destination side 

TERM_50 Terminator 50 ohm 

TERM_75 Terminator 75 ohm 

TERM Terminator unspecified impedence 
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Database Utilities 
WireCAD provides a utility for compacting and repairing databases called CompactDBs.EXE located in the WireCAD2 directory. In 
order for this function to work, all WireCAD v2 users connected to the databases must close the application. If used on a single user 
machine, close all instances of WireCAD v2 before running this utility. Not doing so will cause the utility to fail. 

 

Project Manager Database: Compact and repair the project manager database (dbPM.mdb) located in the WireCAD2 directory. 

 

Equipment Database: Compact and repair the equipment database (dbEquip.mdb) located in the WireCAD2 directory. 

 

Project Specific Database: This button works in conjunction with the Project Specific Databases list box. Compact and repair the 
selected project specific database (ProjectDB.mdb) located in the project directory. 

 

Note: these functions will create a backup of the compacted database appending OLD to the filename. Example: dbEquip.mdb will be 
named dbEquipOLD.mdb. 
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Version 2 Jacks and Jackfields 
This section is copied from the version 2 manual and is here for legacy compatibility. 

Assigning Jack Fields to the Current Project 
In order to make individual jacks available for assignment a Jack Field must first be assigned to the project. During this process you 
will be given the opportunity to build the entire jack field in the current drawing. This process inserts every jack in the jack Field in the 
drawing and fills in all of the information regarding the Jack. 

This function is available from the Jack Fields Library: 

 

 

Select a manufacturer and Jack Field to assign. Next, click the Add Jack Field to Project button. You will be presented with the 
following dialog: 

 

Jack Field System Name: Similar to the Prefix and SysNum fields in the Assign Equipment Function Above. You may type directly in 
these fields. 
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Note: the recommended practice is to type or select the prefix and click the New button to get the next number in the series.  

New: Gets the next number in the series associated with the selected prefix. If the prefix has no associated entries then the New 
function will return 01 as the starting number. 

Jack Field Row Start Designation: Future. 

Jack Field Column Start Designation: Future. 

Location: User defined location field.  

Elevation: User defined elevation field. 

Assigning Individual Jacks 
Double-click on an individual jack to assign it to the database. You are presented a dialog representing the jack field. Green squares 
represent un-assigned jacks, while red squares let you know that the jack is already assigned and in which drawing. 
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Assigning System Names to J-Boxes and Router Cross-points 
Once a J-box or Router Cross-point is placed in the drawing, simply edit its attributes by double-clicking on it. The following dialog will 
appear allowing editing: 

 

 

The following is a table of attributes associated with J-Boxes and Router Cross-points: 

J-Box Router 

Attribute Description Attribute Description 

JF SysName RTR SysName 

CON Connector Layer Router Layer 

F Front or Back of Panel A Cross-point Number 

B Front or Back of Panel B Cross-point Number 

AConn Left Side Connector AConn A Cross-point 
Connector 

BConn Right Side Connector BConn B Cross-point 
Connector 

Location Location Location Location 

SysAlias System Alias SysAlias System Alias 
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Keyboard Shortcuts 
Keyboard shortcuts are defined in a file called “User.ks” in the APPPath\Users\User.ks. User.ks follows this form: 
'///////////////////////////////////////////////////////////////////////////////// 
'/WireCAD keyboard shortcuts. (c)2003 
'/Holbrook Enterprises, Inc. All rights reserved 
'/ 
'/RULES: Modify this file to include your shortcuts 
'/Place your shortcut after the comma, replacing any 
'/existing text. Note that two letter shortcuts 
'/are executed first, next three letter shortcuts. 
'/Any Shortcut longer than three letters must be  
'/executed by typing the <ENTER> key.  
'/ 
'/Example: CMD_LINE,LI would be executed immediately, 
'/as would CMD_CIRCLE,CIR. However, CMD_OSNAP,OSNAP would 
'/require that you press the <ENTER> key to execute it 
'/Note further, that commands cannot contain similar 
'/strings i.e. CI and CIRCLE could not be defined as shortcuts 
'/since anytime CI is typed it will execute immediately 
'/ 
'/WARNING! THERE IS NO TYPE CHECKING OR VALIDATION ON THIS FILE 
'/NOT FOLLOWING THE ABOVE RULES WILL LEAD TO ERRATIC BEHAVIOR 
'////////////////////////////////////////////////////////////////////////////////// 
 
 
 
'////////////////////////////////////////////////////////////////////////////////// 
'/Drawing Tools 
'////////////////////////////////////////////////////////////////////////////////// 
CMD_LINE,DL 
CMD_CIRCLE,DCC 
CMD_CIRCLE_2PT,DC2 
CMD_CIRCLE_3PT,DC3 
CMD_PLINE,DP 
CMD_ARC,DAA 
CMD_ARC_2PT,DA2  
CMD_ARC_3PT,DA3 
CMD_RECT,DR 
CMD_TEXT,DT 
CMD_ATTDEF,DAT 
CMD_POINT,DP 
CMD_IMAGE,DI 
'/////////////////////////////////////////////////////////////////////////////////// 
'/Dimension Tools 
'/////////////////////////////////////////////////////////////////////////////////// 
CMD_DIM_ALIGNED,DDA 
CMD_DIM_H,DDH 
CMD_DIM_V,DDV 
CMD_DIM_RADIUS,DDR 
CMD_DIM_ANGLE,DDG 
'/////////////////////////////////////////////////////////////////////////////////// 
'/File Operations 
'/////////////////////////////////////////////////////////////////////////////////// 
CMD_DWG_OPEN,FO 
CMD_DWG_CLOSE,FC 
CMD_DWG_SAVE,FS 
CMD_DWG_NEW,FN 
CMD_DWG_PRINT,FP 
CMD_DWG_PREVIEW,PP 
'/////////////////////////////////////////////////////////////////////////////////// 
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'/Entity Modification 
'/////////////////////////////////////////////////////////////////////////////////// 
CMD_DELETE,MD 
CMD_COPY,MC 
CMD_MOVE,MM 
CMD_ROTATE,MR 
CMD_SCALE,MS 
CMD_MIRROR,MI 
CMD_STRECTH,ME 
CMD_EXPLODE,MDA 
CMD_TRIM,MT 
CMD_EXTEND,MX 
CMD_SENDTOBACK,MTB  
CMD_BRINGTOFRONT,MTF 
CMD_BREAK,MB 
CMD_FILLET,MF 
CMD_ARRAY,MA 
'/////////////////////////////////////////////////////////////////////////////////// 
'/Object Snaps NOT SUPPORTED YET 
'/////////////////////////////////////////////////////////////////////////////////// 
CMD_OSNAP_END,OSE  
CMD_OSNAP_MID,OSM  
CMD_OSNAP_CEN,OSC 
CMD_OSNAP_NEAR,OSN 
CMD_OSNAP_INSERT,OSI 
CMD_OSNAP_PERP,OSP 
CMD_OSNAP_TANG,OST 
CMD_OSNAP_QUAD,OSQ 
CMD_OSNAP_INT,OSX 
CMD_OSNAP_POINT,OSPT 
'////////////////////////////////////////////////////////////////////////////////// 
'/WireCAD Drawing Tools and Equipment Libraries 
'////////////////////////////////////////////////////////////////////////////////// 
CMD_ASSIGN_CABLE,AC 
CMD_ASSIGN_SYSTEM,AS 
CMD_ASSIGN_JF,AF 
CMD_ASSIGN_JACK,AJ 
DLG_EQUIP_LIB,LE 
DLG_JF_LIB,LJ 
DLG_CT_LIB,LC 
DLG_PCABLES_DS,LPC  
DLG_PSYSTEMS_DS,LPS 
'////////////////////////////////////////////////////////////////////////////////// 
'/VIEW Functions 
'////////////////////////////////////////////////////////////////////////////////// 
CMD_ZOOM_EXTENTS,ZE 
CMD_ZOOM_WINDOW,ZW 
CMD_ZOOM_LAST,ZL 
CMD_ZOOM_IN,ZI 
CMD_ZOOM_OUT,ZO 
CMD_REDRAW,VR  
CMD_REGEN,VG 
CMD_MODEL,VM 
CMD_PAPER,VP 
CMD_MEASURE,VD 
CMD_CALC,VC 
'////////////////////////////////////////////////////////////////////////////////// 
'/Format Dialogs 
'////////////////////////////////////////////////////////////////////////////////// 
DLG_POINTSTYLES,SP 
DLG_TEXTSTYLES,ST 
DLG_DIMSTYLES,SD 
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DLG_LAYERS,SL 
DLG_INSERTS,SI 
DLG_LAYOUTS,SO 
'///////////////////////////////////////////////////////////////////////////////// 
'/Toolbars 
'///////////////////////////////////////////////////////////////////////////////// 
TLB_DWG_TOOLS,TBT 
TLB_DWG_FORMAT,TBF 
TLB_DWG_MODIFY,TBM 
TLB_DWG_OSNAP,TBO 
TLB_DWG_VIEW,TBV 
TLB_DWG_SINGLE_LINE,TBS  
TLB_DWG_DIMS,TBD 
TLB_DWG_COMMAND,TBC 
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License Agreement 
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE OPENING THIS PACKAGE AND/OR 
BY USING THE SOFTWARE. OPENING THIS PACKAGE OR USING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF 
THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD PROMPTLY RETURN THE PACKAGE 
TO THE LOCATION WHERE YOU PURCHASED THE SOFTWARE, UNOPENED WITH PROOF OF PURCHASE, AND YOUR 
MONEY WILL BE REFUNDED. 

 

Holbrook Enterprises, Inc. provides this program and licenses its use.  

Holbrook Enterprises, Inc. retains the ownership of this product. This  

Agreement shall be governed by the laws of the state of Delaware. 

 

LICENSE 

Permitted Uses/You May: 

* Use the software on any computer provided the software is used on only one  

computer and by one user at a time. 

* Copy the program into any machine readable or printed form for backup or  

modification purposes in support of your use of the program on a single  

machine. 

 

Prohibited Uses/You May not: 

* Make copies of the documentation or software, except as noted above. 

* Distribute, rent, sub-license, transfer, or lease the software or  

documentation. 

* Alter, modify or adapt the software or documentation, including, but not  

limited to, translating, decompiling, disassembling, or creating derivative  

works. 

 

This license and your right to use the software automatically terminate if  

you fail to comply with the provisions of this License Agreement. 

 

TERM 

The license is effective until terminated. You may terminate it at any other  

time by destroying the program together with all copies, modifications and  

merged portions in any form. It will also terminate upon conditions set  

forth elsewhere in this Agreement or if you fail to comply with any term or  

condition of this Agreement. You agree upon such termination to destroy the  

program together with all copies, modifications and merged portions in any  

form. 

 

IF YOU TRANSFER POSSESSION OF ANY COPY, MODIFICATION OR MERGED PORTION OF THE PROGRAM TO ANOTHER 
PARTY, YOUR LICENSE IS AUTOMATICALLY TERMINATED. 

 

TRADE SECRET 
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You acknowledge that the software constitutes valuable trade secret  

information that is the exclusive property of Holbrook Enterprises, Inc.. 

 

LIMITED WARRANTY 

Holbrook Enterprises, Inc. warrants for a period of 90 days from the date of  

original delivery to you that the program will substantially conform to the  

published specifications and to the documentation, provided that it is used  

on the computer hardware and with the operating system for which it was  

designed. Holbrook Enterprises, Inc. warrants the diskette(s) on which the  

program is furnished, to be free from defects in materials and workmanship  

under normal use for a period of ninety (90) days from the date of delivery  

to you as evidenced by a copy of your receipt.  This warranty gives you  

specific legal rights.  You may have other rights that vary from state to  

state. 

 

DURING THE WARRANTY PERIOD, IF THE SOFTWARE DOES NOT PERFORM AS WARRANTED, YOUR EXCLUSIVE REMEDY 
SHALL BE TO SEND THE SOFTWARE TO HOLBROOK ENTERPRISES, INC. WHICH SHALL, AT ITS OPTION, EITHER REFUND 
TO YOU THE PRICE PAID OR REPAIR OR REPLACE THE SOFTWARE. 

 

To the extent permitted by applicable law, Holbrook Enterprises, Inc. disclaims all other warranties, either or implied, including, buy not 
limited to,  warranties of merchant ability and fitness for a particular purpose.  Holbrook Enterprises, Inc. makes no warranty as to title. 
No Holbrook Enterprises, Inc. dealer, distributor, agent, or employee is authorized to make any modification or addition to this 
warranty. 

 

LIMITATION OF LIABILITY 

Because programs are inherently complex and may not be completely free of  

errors, you are advised to validate your work. TO THE EXTENT PERMITTED BY  

APPLICABLE LAW, IN NO EVENT WILL HOLBROOK ENTERPRISES, INC. OR ANY OF ITS  

PRINCIPALS OR AGENTS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY TO USE THE PROGRAM OR DOCUMENTATION, even if advised 
of the possibility of such damages. Specifically, Holbrook Enterprises, Inc. is not responsible for any costs or damages including, but 
not limited to, those incurred as a result of lost profits or revenue, loss of use of the computer program, loss of data, the costs of 
recovering such programs or data, the cost of any substitute program, claims by third parties, or for other similar costs. IN NO CASE 
WHATSOEVER SHALL HOLBROOK ENTERPRISES, INC.'S LIABILITY EXCEED THE PRICE PAID FOR THE LICENSE TO USE 
THE SOFTWARE. 

 

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 

 

Should you have any questions concerning this Agreement, you may contact  

Holbrook Enterprises, Inc. by writing to: Holbrook Enterprises, Inc. 24421 Chestnut Street Suite 101, Newhall, CA 91321 

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms and conditions. You further 
agree that it is the complete and exclusive statement of the agreement between us which supersedes any proposal or prior 
agreement, oral or written, and any other communications between us relating to the subject matter of this agreement. 
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